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Preface

About this guide

This guide explains how to use the Micropak 75XL simulator based
development tool.

The first section, Introduction, provides arapid overview of the product
and itsintended uses.

The next section, Installation, explains the steps required to install
Micropak 75XL onto your system.

The Fast Startup Guide provides concise instructions on using the
simulator for creating and debugging projects. This should be used to
gain an overview in using and controlling the tool.

The Tutorial section takes you through, step by step, a sample debugging
session and includes illustrations of some of the various ways the product
can be used and the facilities it offers.

User Interface Details is awide ranging section, covering the elements of
the Micropak 75XL screen display, the operation of the menu system, the
tool bar and the other possibilities for controlling the simulation. This
section also describes the operation of the on-line help facility.

The next sections explain the fundamental facilities in more detail and
include Navigating and Editing Project Files, Controlling Execution,
Trace Buffering and Breakpoints.

The Port Simulation section gives important details of the approach
adopted for the simulation of port lines and discusses ways in which these
can be used to establish and test the interactions of the target firmware
under test with external hardware.

Micropak 75XL enables the states of multiple aspects of the simulation to
be viewed and monitored, many whilst the simulated code is executing.
These facilities are explained in the Viewing Simulated Objects section of
the user guide.
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The final section, Using Script Files, describesin detail the usage, scope
and flexibility of the in-built script file processor, which can significantly
increase the power of the test environment whilst also improving testing
productivity. It isrecommended that this section is studied carefully
before planning a detailed testing or devel opment programme, especially
where repetitive or regression testing is intended.

Appendices
There are two appendices.
Thefirst contains a definition of the script file grammar.

The second appendix contains the script file example used in the
tutorial. Thisillustrates how the script file mechanism can be used to
extend the simulation to mimic the behaviour of externa hardware.
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Introduction The 75XL microcontroller family

Introduction

The 75XL microcontroller family

The 75XL family of devices are tailor-made for very specific, high-volume
applications and offer an extremely attractive cost-performance ratio.

The family includes a variety of devices with differing on-chip peripheral
sets intended for differing application areas. All the devices feature a 4 bit
wide data RAM and an 8 bit wide program ROM area.

Micropak 75XL - An overview

The ‘simulation engine’

Micropak 75XL isan advanced simulator based tool for developing and
testing applications for the NEC 75XL family of microcontrollers.

The simulation includes the full CPU core and registers, on-chip
peripherals and 1/0 ports, and is performed totally in software in the host
PC - no external hardware is required.

Application code to be investigated can be loaded into the software
simulation and run, just asin hardware based environments.

Execution time assessments

The effective speed of the test code execution will vary with the speed of
the host PC and with other factors such as the detailed composition of the
target program. However, although the simulation does not therefore
execute in real time, the execution time for each individual instruction is
calculated and totalled by the simulation engine, so that detailed
time-critical code sections can be assessed and detailed execution time
measurements can be made.

Micropak 75XL User Manual 1



Introduction

Port simulation

The simulation allows an external ‘ Thevenin’ equivalent network,
consisting of a single external voltage generator and a single external
series resistance, to be connected to each port line,. Both the voltage and
series resistance can be controlled via the user interface or the script file.
Extending the simulation in this way allows you to investigate the
interaction of the firmware under test with external hardware components
such as switches, LEDs, etc. It also alows checks on the drive capabilities
of the ports, and the use of pull-ups and so on.

Using Micropak 75XL in conjunction with OTP devices

Interactions with complex hardware peripherals are difficult to emulate
with the simulation alone, and in these situations one-time programmable
devices may offer arealistic low-cost development route. In these cases
the structure and basic behaviour of the code under scrutiny can be
developed in the simulated environment, ready for subsequent trialsin
one-time programmabl e devices to confirm the correct operation of these
more complex interactions.

The user interface

The user interface of the product adheres to the accepted conventions for
Microsoft Windows applications, reducing to a minimum the overhead
associated with learning to control the facilities provided. Extensive useis
made of the graphical capabilities of the interface to provide a clear and
attractive display. The ability to make significant eventsin the target
system visible is considered to be a strong feature of the product and can
boost debugging productivity considerably.

An inbuilt editor isincluded to support program development during
debugging, with automatic links to the 75X tool chain to trigger and
control re-assembly.

The program is intended to interact with the 75X assembler, structured
assembler, macro-processor and linker. It includes facilities which allow
the execution of the program to be monitored at assembler source level.
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Introduction 75XL devices supported by Micropak 75XL

The script file processor

The product includes a powerful ‘script’ file processor which can monitor
and control eventsin the simulated target system according to control
‘programs’ written in the script language. Script filesuse a‘BASIC-like’
syntax and can be used to mimic the behaviour of external devices or to set
up, run and check the results of repetitive or regression tests.

Using Micropak 75XL in quality and other formal testing
regimes

In addition to its devel opment facilities, the simulator can aso be used for
formal qualification or other quality testing. Powerful batch testing
facilities are included, simplifying the execution and documentation of
regression testing after product firmware changes.

75XL devices supported by Micropak 75XL

For alist of the 75XL family members currently supported by the
Micropak 75XL simulator, please see the README file on the
distribution diskettes or contact your NEC representative. A list of
supported devices is aso given in the on-line help provided for the
product.
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Installation The important files

Installation

This chapter explains the steps required to install the Micropak 75XL
software, both in terms of running the SETUP facility provided on the
distribution diskette(s) and creating a suitable directory structure for your
project files.

The important files

The following files are supplied on the distribution diskette(s):
MP75XL.EXE the main executable file

MP75XL.HLP the help file for the Micropak 75XL
program

CPYOUTPT.* pipe tool program files used to pipe output
between items in the tool chain

README.TXT  thisdescribesinstallation instructions and
the devices currently supported

Tutorial files for running the tutorial detailed in this user
manual

Note that you will also need the 75X assembler, or an equivalent, in order
to generate object code to run and test. Throughout this user manua it is
assumed you will be using the 75X assembler.
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Suggested directory structure Installation

Suggested directory structure

The suggested directory structure groups al the Micropak 75XL related
files under amain MP75XL sub-directory but splits the Micropak 75X L
executable and help files from the source code and other project specific
files.

Although other directory structures are possible, care must be taken to
ensure that the run-time links to the pre-processors, linker and assembler
from Micropak 75XL will operate correctly. The mechanisms used, and a
summary of the links which must be preserved, are described later in this
chapter under the heading ‘ Run time links to the 75X tool chain’.

The following default directory structure is used by Micropak 75XL:

[ DRIVE :\

] MP75XL\
— ] BIN\
L] TUTORIAL\
—L ] PROINAMI\
— ] PROINAM2\

The BIN sub-directory contains all the executable files, with the exception
of the build tool executables. Note that the tutorial files are not required
for the normal operation of Micropak 75XL.
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Installation Running the SETUP utility

Project specific directories

The sub-directories such as PROINAM1 and PROINAM?2 are intended to
hold project specific files, including the source files and the project batch

file, which is used by the project re-building function to make the project.

It is recommended that these sub-directories are given meaningful names
to reflect the projects they represent, such as METER or TIMER, etc.

Running the SETUP utility

The distribution diskette contains a* SETUP.EXE’ installation program
which is used to create an appropriate directory structure on the working
drive and copy al the necessary files from the distribution diskette into the
new directory structure.

The SETUP program must be run from within Microsoft Windows.

Run time links to the 75X tool chain

Micropak 75XL includes facilities for re-building and building complete
executable code from the source using the standard components of the
NEC 75X tool chain. These components are not installed as part of the
Micropak 75XL set-up and must be installed separately. Locate the tools
in an appropriate directory (e.g. ‘NEC') and edit the * Autoexec.bat’ fileto
add this directory to the *path’ entry.
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Fast Startup Guide Starting the Micropak 75XL simulator

Fast Startup Guide

This section gives an overview of the major facilities of the Micropak
75XL simulator to enable the user to begin working with the tool.

Starting the Micropak 75XL simulator

To start the Micropak 75XL simulator locate the *Micropak 75XL" group
window and double-click the ‘Micropak’ program icon contained within
it:

Setting up and debugging a new project

The Micropak 75XL simulator provides a complete environment for
writing, editing, assembling and testing your program. The environment
for thisis caled the ‘Project’” and therefore the first step isto create a new
‘Project’ using the following steps:

Create an appropriate directory for the project, either using
‘File Manager’ or the DOS ‘md’ command.

Create anew project file by selecting ‘New’ from the ‘ Project’
menul.

Inthe ‘New Project’ dialog box, type the path and name of the
project batch file (or click the ‘Browse' button, locate the
project directory and specify the name of the batch file). Note
that the batch file must have the same name as the project
directory and a‘.bat’ extension. Select the processor type
from the list.

Micropak 75XL User Manual 9



Opening an existing project Fast Startup Guide

Create the assembler source files by selecting ‘New’ from the
‘File’ menu. Savethe source files by selecting ‘ Save As' from
the ‘File menu. Assembler source files can subsequently be
edited by selecting ‘Open’ from the ‘File' menu.

Invoke assembly of the source modules to create a runnable
program by selecting ‘Rebuild All’ from the ‘ Project’” menu.

Create a test environment for the project including RAM
displays, peripheral and port views, signal traces, setting
breakpoints and building customised test panels, as desired.

Debug the software using the various ‘Debug’ options
including fast and slow run modes, setting the PC at a ROM
address, tracing, etc.

Opening an existing project

Once a project has been created the project environment can be re-invoked
at subsequent debugging sessions without the need to re-defineit. The
following steps should be used to open an existing project:

Select ‘Open’ from the ‘Project’” menu.

Continue with debugging the code, editing and re-building as
necessary.

10 Micropak 75XL User Manual



Fast Startup Guide Common debugging features explained

Common debugging features explained

How to set a breakpoint

Breakpoints can be set on program locations, memory read/writes and
peripheral read/writes. Breakpoints are set by selecting ‘ Breakpoints
from the ‘Debug’ menu. Thereis also atoolbar icon for setting or
clearing a breakpoint at the current cursor position.

How to start/stop execution

A set of execution control facilities are available from the * Debug’ menu.
Execution starts from the current program counter position. The ‘ Reset’
option, also available from the ‘ Debug’ menu, resets the simulated
processor or may be positioned anywhere in the code. Execution will
terminate according to the option selected, e.g. at the current cursor
position, or at the next instruction, or whenever a breakpoint is reached.
A specific ‘stop’ instruction is also provided. All these facilities are
available from the ‘Debug’ menu and as a collection of toolbar icons.

The time duration of an execution can be monitored using the * Timing’
window, which is displayed by selecting ‘ Timing’ from the * Window’
menu.

How to edit source programs

Any text file may be created and edited using the options available from
the ‘File’ and 'Edit’ menus. Syntax colouring of source programs can be
applied if required so that, for example, labels and instructions are
displayed in different colours. All normal editing functions are available,
including ‘Cut’, ‘Copy’, ‘Paste’, ‘Undo’ and ‘Find’.

How to navigate files

The *View’ menu option provides a number of facilities to help traverse
active files, including jumping to a given line number. Bookmarks can be

set in afile alowing the user to rapidly move to pre-defined points within
their source files.
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Common debugging features explained Fast Startup Guide

How to view data items

A ‘Data’ window can be displayed in order to view specified areas of
RAM by selecting ‘Device' from the *Window’ menu. Information about
specific data items can be viewed temporarily using the * QuickWatch’
facility or monitored continuously using the ‘Watch’ facility. Any data
item in the * QuickWatch’ window can be subsequently moved to the
‘“Watch’ window by selecting * Add to Watch' from the ‘ QuickWatch'.

How to display peripherals and ports

The simulation of device peripherals and ports can be viewed by selecting
the ‘Device' from the ‘Window’ menu then choosing from the displayed
list. Onewindow will be displayed for each item selected.

Ports can also be displayed in signal windows. In thisinstance the port
values will be shown as a‘scope-like display. Thisfacility can be
selected by choosing ‘New Signals from the ‘ Trace’ menu.

How to build customised displays

Customised displays are built as test panels, where each panel can contain
one or moreitems. The display of these items is controlled through the
script file mechanism. In this case, the value of items such as script file
flags and buttons are displayed to show the results of script file events.
Test panels are defined by selecting ‘New Panel’ from the ‘ Test’ menu.

How to create script files

Script files are created by selecting ‘New’ from the ‘File’ menu These are
text files containing ‘BASIC-like' commands to control execution and to
perform events at specified points during the execution. A full list of the
script file commands is given in the chapter entitled *Using Script Files'.
Once a script file has been created it may be executed at any time.

The appropriate script options, available from the * Test” menu, are used to
perform these tasks. Tool bar icons also exist for starting and stopping
script file execution.
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Fast Startup Guide Common debugging features explained

How to invoke tracing

A trace buffer is provided and can be switched on and off at random to
capture required sections of executing code. Thisis achieved by selecting
‘Debug’ from the *Options' menu and clicking the appropriate check box.

The buffer contents can be displayed using the ‘ Trace’ menu options.
How to configure the environment

The *Options' menu and the *View’ menu contain a number of items
which can be configured.

The *Options’ menu includes the following:

‘Debug’ options. Here you can select the run mode (‘fast’ or
‘dow’), select trace buffering and enable signa output. You
can aso specify the size of the signal and trace buffers and the
maximum number or time duration of script file instructions
to be run for any one event.

‘Editor’ options. Here you can select the number of tab stops,
the size of the ‘undo’ buffer and enable/disable the scroll bars.

The *View’ menu includes the following:
Screen items. Thetool and status bars can be turned on or off.

Syntax colouring. Syntax colouring available for editing
source files can be turned on or off.

How to set up automatic testing

Automatic testing can be achieved by writing one or more script files.
Each test must be planned in detail and the correct test panels built to
show the required output from the test.

How to obtain help

An on-line help facility is provided and is accessible by using the ‘Help’
menu option or by pressing the F1 key.
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Tutorial The example application - stepper motor control

Tutorial

This section details an example Micropak 75XL session, giving
illustrations of the various ways in which the simulator can be used and
the facilities it offers.

The example application - stepper motor control

The target code we use here is intended to control a stepper motor in
response to two simple push-button control switches. The hardware
environment isillustrated in this block diagram:

uPD30112

[
P2 3 drive buffers

P1.0 p2 2

‘o P2 .1 %D; ? pats
B R=10K ” .Ogb—l; @ L

*Sor P1.1 ]
* 1

ov

The simple stepper motor driver used as an example

A device will drive the 8 phases of a stepper motor via appropriate drive
buffers.

Drive control is to be by two simple push buttons each of which iswired so
that operating the push button switches a port line between GND and Vdd.
Port 1 pin 0 is used for the *START’ button and port 1 pin 1 is used for
the ‘STOP' button. The individual motor phase coils are to be driven
from the 4 pins of Port 2.
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Setting up the test environment Tutorial

What the example firmware needs to do

The firmware must generate the appropriate series of stepper motor drive
signals.

It should also monitor the state of the push buttons to detect switch
operations and interpret these so that one button shall cause the stepper
drives to start, and the other shall cause the motor to stop. Only new
switch presses should be actioned.

From the point of view of initialisation and preparation, the firmware will
need to activate the output buffers for the stepper outputs, and set up an
on-chip timer to trigger the timing of new phase drives. We will return
for amore detailed look at the firmware later, but for the moment we must
consider what is required for the test environment and how this
environment is created using the Micropak 75XL simulation.

Setting up the test environment

In order to exercise the controlling firmware it will be useful if we can set
up Micropak 75XL to mimic the effect of the two switches, and to monitor
the phase drive outputs.

The switches and phase drives are the basic inputs and outputs of the
controller and are therefore the minimum we need for ‘black box’ testing.
However, it will probably also aid the debugging process if we can see the
activity of theinternal timer used for stepper phase timing and some of the
important program variables. We will then be able to see the relation
between the internal activity of the firmware under test and the actions it
makes on external conditions.

Creating a new project

We start by creating a new project batch file for the firmware under test.
Select the menu options ‘Project’, ‘New’, and then enter the name of the
project filein the file box ie:

‘tutorial.bat’

At this point the processor to be simulated can be chosen from a selection
list. You may however leave the default processor at this time.
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Tutorial Setting up the test environment

Editing the project file

The next stage is to edit the project file in order to specify the source files
for the project and the linker option. Y ou should therefore select the menu
option ‘Project’ *Edit’. Files can then be selected from the file list for
inclusion in the project. Each file isincluded by making your selection and
then pressing the ‘Add’ button. The following file must be included :-

stepper.asm

Once this file has been added to the project you should press the ‘ Close’
button.
Building the project

Now that the project contents has been specified you should instigate a
project rebuild to generate the target code. This can be done by selecting
the ‘Project’ *Rebuild All" menu or by using the following tool bar icon :-

The Rebuild All icon

Output from the build tool chain will be shown in the output window.
When the re-building process is finished, the output window should be
closed and you will then see the source code displayed in a source window.

Displaying peripherals and data

Peripheral and dataitems for display may now be selected. To display the
internal timer therefore select ‘ Device' from the ‘Window’ menu to obtain
alist of the device windows available and select the ‘ Timer/Event Counter
0. Theillustration below shows the selection of the timer device.

Once opened any window may be moved, re-sized, maximised or
minimised as in any standard Windows application. The second
illustration below shows the timer window selected.
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Setting up the test environment Tutorial

Here we are selecting awindow for display:

Device:

Port 2

Port 3

Port 4

Port 5

Port b

Port 7

Clock Output

Basic IntervalMwatchdog Timer
Wwatch Timer
Timer/Event Counter 0
Timer/Event Counter 1
Timer/Event Counter 2
Clocked Serial Interface
LCD Controller/Driver
Bit Sequential Buffer
Interrupt Control

Using the menus to select a timer view item

Hereis the resulting device window:

= 1 * | -

TH3: THOD:
THZ: IEI T:

TOE: THE-4:

1 TOUT: [g |

This window shows the states and activity of the internal timer we will be
using. At thisstage, (i.e. before executing any program sections) this will
bein the ‘reset’ condition.
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Tutorial Setting up the test environment

Setting up the push buttons

Setting up the switch simulations requires a little more thought. Micropak
75XL includes for each port line, the ability to simulate a single (perfect)
external voltage generator in series with a single external series resistance.
The voltage of the generator and the resistance of the series resistance can
both be changed as required whilst the simulation is running.

Furthermore a connection between the external circuitry and the port can
be set or broken. For more information about this facility see the later
section on Port simulation techniques.

For our purposes here, we can use this possibility to simulate the two
conditions of the switches by changing the voltage generator from Vdd to
GND and vice versa
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Setting up the test environment Tutorial

The following illustration shows the pin windows set up with required
values. To enter values you merely overtype in the relevant boxes. The
illustration shows the two connections in the Vdd condition.

B_piown_EE BEGTIUNEE
| (17—

Ed:Connect: (<] Connect

aw v |
H Ri [ohm]: 1 Ri [ohm]: H

The port pin windows show and set pin conditions

We will start with the switchesin the Vdd condition. Select *Pin’ from
the “Window’ menu to display alist of all possible pins. Then select
‘P10/INTO" and ‘P1L/INTY from thelist to display these windows: now
set the external network components (Vi) and (Ri) of each pin with the
values shown above. Finaly, click on the connect boxes of each pin to
make the connections.

Phase output drive displays
It will be interesting to monitor the drive outputs in two ways.

Firstly, we can set up aview in which the state of the outputsis
represented as a circular pattern, as an analogue of the physical
arrangement of the associated coils within the motor itself.

Secondly we can use the Micropak 75XL plot recording style of displays
in signal windows to show the detailed timing relationships between the
phased outputs.
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Tutorial Setting up the test environment

Setting up a test panel of grouped items

Test panels containing groups of items for display can be specified.
Firstly, select ‘New Panel’ from the ‘ Test’ menu to provide a new test
panel in which to work. A palette will be displayed showing the items you
can display. For this example we will select aflag item for each of the
individual Port 2 output lines. Thisisillustrated below:

Individual phases - inverse video means active

Item types, either buttons, flags, text or edit boxes are selected from the

palette which is displayed when the edit mode is entered and these items
can be placed in the test panel by ‘clicking’ the mouse at the required
position in the panel.

Y ou should select the ‘flags' option by clicking the ‘flag’ radio button in
the palette window. Y ou should then place four flagsin the panel by
moving the mouse to four different places, clicking on each place to set
down one flag. The move option may then be selected to make any further
adjustments to the positions of the flags or to delete flags.
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Setting up the test environment Tutorial

The final task is to specify the properties of the flags. A properties dialog
box can either be selected from the * Test” menu or by double-clicking the
flag when ‘Move' is selected on the palette. The properties of each item
consist of a unique caption to be displayed and an identity which is used to
connect the item with script file control. Y ou should give the names
“phi_0" to “phi_3" as both the identity and the caption for each of the port
lines respectively.

The visual state of each item (either normal or inverse video) is controlled
by the actions of a script file which will need to be invoked in order for the
test panel to be activated. The facilities provided by the script language
are described in later section. However, for our purposes we need to be
aware that to use these facilities it is necessary to define a test panel
containing the items for display and to set up a script file to define the
conditions for controlling the display of the items.

Using the editor to define a script file

In order for the items in the test panel to display the status of the port
lines, a script file needs to be written. Here we will use the editing
facilities of Micropak 75XL to write asimple script file for this task:

p46% = pi n(46)
p47% = pin(47)
p48% = pi n(48)
p49% = pi n(49)
on event (p46% run show
on event (p47% run show
on event (p48% run show
on event (p49% run show
event (p46% on
event (p47% on
event (p48% on
event (p49% on

end

show:
setflag "phi_0", getv(46) > 2.5
setflag "phi_1", getv(47) > 2.5
setflag "phi_2",getv(48) > 2.5
setflag "phi_3",getv(49) > 2.5

end

A sample script file to input
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Tutorial Setting up the test environment

Script files consist of one or more event handlers. The first initialisation
event handler defines the conditions to be recognised and enables further
event handlers to perform the tasks required when the relevant conditions
are encountered during the simulation. In thisinstance our initialisation
handler consists of four ‘addpin’ statements, one for each of the phase
output pins. The numbers (46,47,48,49) correspond to real pin numbers
on thedevice. All four statements are similar and define ‘show’ as the
entry point of the handler to be used whenever the corresponding pin
voltage is changed. Thus after initialisation any change in voltage on any
of these pins e.g. pin 46, will trigger the event handler ‘ show’. ‘show’
fetches simulated pin voltages for all four pins and updates the test panel
flag items caled ‘phi_0, ‘phi_1’ etc., to show the current pin conditions.

The screen display above shows the contents of the script file to be created.
Y ou should open a new file by selecting the ‘New’ option from the ‘Fil€
menul.

Y ou can then enter the text directly using the normal edit facilities and
save the file when complete, giving the file name:

PORTO0.SCR

To see how the script file operates you must select * Run Script’ from the
‘Test’ menu.

To check the operation of the script you can now enter some values
directly into the port 2 and you will see the test panel display change
according to the values entered.

To do this you should open the port 2 window by selecting ‘ Device' from
the “Window’ menu and choosing port 2 from the list of devices. In order
to effect changes to the port you will need to set the ‘PM’ box in the
window to ‘1’ (port mode as output) and then if you enter values into the
pin boxes in the window you should see the display in the test panel
change. What is happening hereis that these actions trigger the script
event handler ‘show’ which then updates the test panel.

We can now move on to an alternative possibility for displaying port
conditions.
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Setting up the test environment Tutorial

Setting up a plot recording of the drive lines

Selecting ‘New Signals' from the ‘ Trace’ menu will display an empty
signal box. Y ou must now specify the items you wish to plot by choosing
‘Edit Signals’ from the ‘ Trace’ menu. A list of itemsfor plotting is shown
and you can specify theindividua port lines, clicking the ‘Add’ button
after each selection. This action will include plot linesfor all 4 port 2
outputs simultaneously.

In order for the signal window to plot the lines during processor execution
we must enable the signal operation and ensure that the signal buffer is set
to a size capable of holding enough information for plot records. To do
this select ‘Debug’ from the ‘Options' menu. A dialog box will appear, on
which you should click the ‘signal enable’ check box and enter a value of
‘1’ (representing 1 second), as the size of the signal buffer.

The signal window will initially appear empty. The plots are only drawn
as the simulation progresses. Hereis an example of how the box might
appear later when you have run the firmware:

FZ0/PTO0; w0 = 0.000 %, w1 = 0.000 %, dv = 0.000 Y +
5
i
0
[F21/FPT01: »0 = 0.000 %, v1 = 0.000 %, dv = 0.000 % |
5
i
0
P22/PCL/PTOZ/REM: w0 = 0.000 ¥, w1 = 0.000 ¥, dv = 0.000 ¥
5.
v R R RRRRER
l].
P23/BUZ: w0 = 0.000 %, v1 = 0.000 %, dv = 0.000 ¥
5.
v SRR R R
l].
30 40 50 60 70
Time/ms: t0 = 0.000 s, H = 0.000 =, dt = 0.000 =, 1/dt = 1/0 +
wll [ [

Signal windows show the relative timing of signals clearly. They can be
scrolled backwards to see the past changes. The amount of past detail that
is stored depends on the buffer size. For more information about using
plot records see the later section.
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Loading the example firmware

The distribution disk contains the necessary source and other filesto see
the example running. Assuming that you opted to install the tutorial,
these files will be in an appropriate directory on your system and you can
load and run the sample program. In thisinstance the files will have
automatically been loaded when you rebuilt the project and a source
window displayed. If you have minimised this window you should now
restore:

= STEPPER.ASM M =
: START |4
: Thi= i= where the program starts.
étart:
ZLRE1 HMEE ; Enable Hemory Bank 0 and HE1G
MOV HA #0 ;. Stack pointer =et
HOW SPLXA S at RAM address OFF Hex j
MOV A&, #0011E ; CPU clock high speed mode, cycle
HOV PCC,A o time = 0.95us at 4.19 MHz guartz
CALL !PortInit  Initialise the ports
BE ZeroRam ; =et the RAM contents to 0O
RZexroRam:
o return addr from zeroram — note cannot
o use call as the stack is cleared
; initialise RAM wariables
SET1 =tepping ;. start with motor stepping
SET1 MEE
SEL MEO r
- -

A sample source file

The sourceis displayed asit isheld in the file. That is all user comments
etc areincluded in the display.

The scroll bars, the cursor and PgUp, PgDn keys enable you also to scroll
forwards and backwards through the example source code. Use these
facilities to examine the example source code, and relate it to the
descriptions which follow. The *View’ menu has options for setting and
removing ‘Bookmarks' in the window and moving between the marks set.
Lines on which Bookmarks have been set are coloured with acyan line.
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Understanding the example Tutorial

Understanding the example
Timing

The main features of the system timing are shown below:

petonded N RN AR RN RRN RN R AR RN AN
underflows \

P2 .3 o L] L] L
P2 .2 7 7 L] |
= I s [ R I e
I I N

The timing of events in the example
The on-chip timer is used to generate a regular timing interrupt.

Thisinterrupt causes a period counter to be decremented. When this
counter reaches zero, a new phase pattern is driven to the motor circuitry
and the period counter is reloaded to time the next inter-phase gap.
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Program flow

The flow chart which follows shows how the program is structured to
perform these various actions.

initialise

settimer_tickflag

timer_tick flag
' returnfrominterrupt

waitfortimerint.

scan buttonsand
update stepping flag

decrement counter

— counter=0

reload counter

no
.= step motor
yes |

Control flow in the example

After initialisation, control enters the main loop.

Each pass round the loop is synchronised to the timer interrupt by waiting
at the start of the loop until the flag ‘ TimerTick’ is set by the timer
interrupt handler.
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Understanding the example Tutorial

The activities of the loop begin by scanning the ‘start’ and ‘stop’ buttons
and setting or clearing the drive flag appropriately. Next, the period
counter is decremented and tested. When there are no more ticksin this
interphase period (i.e. the counter reaches *0’) the counter is reloaded with
the value of the current period. The drive flag is then tested to seeif the
motor isin operation. If it is, a new phase pattern is driven out to the
motor.

Initialisation

The initialisation function is run first. This sets up the program variables
to appropriate initial states and sets up the interrupt controller and timer
to generate atimer interrupt at preset intervals. Program variable set up
includes setting the phase state to zero, and the counter, which counts
down to the next phase, set to the maximum value ready to start counting
down. The drive flag, indicating whether or not the motor is operational,
isset to ‘ Stepping’ ie active.

Finally, interrupts are enabled, and control passes back to the main loop.
Main code

The code consists of a continual loop. Firstly, when anew key pressis
detected, the motor is switched on or off accordingly. Then a test of the
flag set by the timer interrupt is made . When this is detected, the switch
lines are scanned by appropriate routines one by one.

The period counter (‘count’) is decremented at each pass of the loop.
When it reaches zero, it is reloaded with the variable ‘period’. The drive
flag is then tested to determine if the motor is operational, and aroutineis
called to drive new phase outputs. Control then returns to the start of the
loop.
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Understanding the example

Mai nLoop:

MOV A tiner_tick
over f | owed)

SKE A, #0
BR SeenTi mer 0
BR Mai nLoop

SeenTi ner O:
MOV A, #0
MOV tinmer_tick, A
CALL !SIfStartButton
CALL ! Start Stepping
CALL !SI f StopButton
CALL ! St opSt epping
MOV A, count
DECS A
NOP
MOV count, A
SKE A, #0

BR Mai nLoop

while (timer O has not

{}

reset timer overflowed flag

if (push_on_start_button)
{ start stepping }

if (push_on_stop_button)
{ stop stepping }

count = count -1

count reached 0O

no

The main line code
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Understanding the example Tutorial

Processing functions

In the example, for clarity, the task is broken down into several functions.
They perform the following :

scanning for new button presses (one for each of the two
buttons).

getting a new phase into the motor drive outputs.
setting a new phase into the motor drive outputs.

These individual routines are relatively straightforward and are not
specifically listed here. Y ou can inspect the source for these routines by
scrolling the code displayed in the source window.

Interrupt handler

Thetime interrupt is kept as simple as possible. The only significant
action is the setting of the flag which the main line code tests to detect the
passage of another interrupt period:

Timer O interrupt

| _TinerO:
MOV A #1 ; record tick for main line code
MoV timer_tick, A

RETI

The handler for the timer interrupt

30 MP75XL User Manual




Tutorial Executing the code - The PC indicator and cursor

Executing the code - The PC indicator and
cursor

We are now ready to try executing the code. First of all, generate a reset
in the system by selecting ‘Reset’ from the *Debug’ menu. The PC will be
set on thefirst line of the real program and is shown by ayellow bar. This
will be at the label Reset.

Scroll down through the code and observe the PC indicator until you reach
the main loop at the label MainLoop.

Click on thefirst line of code after the function declaration ie the call to
theinitialisation function. The cursor is set here.

Go to cursor

Y ou can now give the * Step to Cursor’ command to execute the program
to this point. This command can be given either by selecting ‘ Step to
Cursor’ from the ‘Debug’ menu or by clicking the appropriate tool bar
icon:

The ‘Step To Cursor’ icon

When execution arrives at this point, you will notice the program counter
(PC) indication by the changed colour at thisline.

The source line, which corresponds to the current program counter
position, is shown in yellow. Because the program counter points to the
next instruction to be run, the yellow line is the one that is about to be run.
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Executing the code - The PC indicator and cursor
Tutorial

Single Stepping

It will be interesting to watch the effects of the code on the view items we
have aready set up. Single stepping gives you the opportunity to observe
these individual effects clearly, instruction by instruction.

Single stepping can be done by selecting * Step Into’ from the * Debug’
menu or by clicking the appropriate tool bar icon:

)

The ‘Step Into’ icon

As execution proceeds you will see the yellow bar showing the current
program counter position gradually move through the routine.

Notice that because the program counter points to the next instruction to
be executed, the PC indication shows the actions that are about to be
performed, not the action that has just been carried out.

Animating the code - multi stepping

Multiple stepping executes one step at a time, and displays the program
counter position after each instruction by moving the yellow bar. This
function, sometimes known as ‘animation’, shows execution moving
through the code, making program flow clear.

Animation can be started either by the selecting ‘Go’ from the * Debug’
menu or by clicking the appropriate tool bar icon:

I

The ‘Go’ icon
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Tutorial Simulating button presses

Note, however, that because the whole screen display is updated, including
re-writing the source window and showing the program counter bar,
execution speed in *animation” mode can become slow. When using this
maode of execution speed may be increased by minimising those windows
you are not interested in observing at thistime. This applies to the listing
window as well as the device windows.

Fast debug mode

Having observed the individual stages of initialisation we can now proceed
to run the code in afast debug mode. In this mode, only the test panels
are updated during execution and therefore the speed of execution is
increased. To initiate this mode either select *Fast’ from the *‘Mode' field
of the ‘Debug Options’ window, having selected the latter from the
‘Options’ menu, or click the appropriate tool bar icon:

=] =]

The slow icon (A tortoise) The fast icon (A hare)

Running in fast mode should enable you to see the stepper drive activity as
acirculating effect in the test panel display.

Simulating button presses

With the code running, we can now investigate the behaviour of the
firmware in response to button presses. For thisyou should return to the
slow debugging mode, so click on the debugging mode icon to return to
dow mode. The icon shown represents the current state, so you should
click on the *hare’ to show the ‘tortoise’.
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Test context files Tutorial

Y ou can simulate the effect of a push-button operation by changing the
voltage generator from 5to 0. This mimics the effects of the switch
operation causing the voltage at that pin to fall, triggering the main loop
to detect a switch operation and stop the motor. To perform this task you
should either restore or make active the pin window P11 (the stop button)
and change the voltage by clicking on the ‘ connect’ box to disconnect. To
release the button you would change the voltage back to 5 again, however,
you should pause for a short while between the operations to ensure that
the switch sensing code sections are run.

To start the motor again you should simulate a button press on pin P10.
The results of each button press should be seen in both the test panel
display and the plots recorded in the Signal window.

Test context files

So far we have seen how to set up atest environment and use it to run our
target code. You may find it useful to save this environment in order to
re-instigate the test at alater stage. To save your panel file choose the
‘File’ ‘SaveAs option. The file should be saved with the extension .PAN.
The conxtext information including information on the windows and
panels were open and their position may be saved through the ‘ Test’,
‘SaveAs menu option. Y ou must give the test context afile name when
saving it. If you wish the context to be opened automatically when you
open a project you should give the file the same name as the project name.
The extension is.TST.

When we started the tutorial we did not open an existing project file, as
the tutorial was described to create anew one. An example project file for
the tutorial is provided to go with the tutorial example:

stepper.bat

To invoke this use the * Project’, * Open’ menu sequence. Y ou will then
see a pre-defined set of windows appear on the display. The next section
describes how test simulations may be made easier and faster by using
script files associated with the pre-defined project context file.

A new window displaying two ‘Window style’ buttons, labelled as * Stop
button’ and ‘ Start button’ will be seen. These items are linked via the
script file to the two button sensing pins.
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Tutorial Using the script file

This is how the new window will appear:

Start

The context file reads in the test panel

Using the script file

Micropak 75XL includes a‘script file' processor as described briefly in an
earlier section. This allows events in the simulated environment to be
controlled and monitored automatically according to details defined in the
script file. Script files are described more fully in alater section, but we
will illustrate their use here by providing a more convenient way of
running our test session.

The distribution disk contains a sample script file to go with the tutorial
example:

stepper.scr

To invoke this, select ‘Open’ from the ‘File menu. Thiswill display a
dialog box alowing thefile to be loaded. Select or enter the name
(‘stepper.scr’) and the script file itself will appear in a‘text window’.
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Checking the generated sequence Tutorial

To action the script in the file, use the menu option *Run Script’ from the
‘Test” menu to action the file commands. The results of any further
simulation will then cause changes to the display according to the events
translated by the script file.

Clicking on the button items shown in the new test panel will toggle the
voltage switch on pins P10 and P11 to simulate the button presses and
releases.

For more details see the later section on script files.

Checking the generated sequence

If you study the generated output phase signals carefully you may notice
an anomaly. In fact, the example program includes a bug, which results
in one of the patterns driven out to the port being incorrect and showing
all the lines being driven high together. Thiswill result in a disturbance
to the circulating pattern and can also be seen in the plot record display in
the signal window.

Tracking down the bug

In order to find the problem we will set a breakpoint just after the code
line which sets new phase patterns into the hardware.

We will also activate trace buffering so that we can *backstep’ from the
breakpoint, to see the code line which generates the incorrect pattern.

Firstly, we must stop our current execution. To do this use the ‘ Alt-F5’
key or select ‘ Stop Debugging’ from the ‘ Debug’ menu.

Setting a breakpoint

Scroll through the code until you find the statement:
call INewPhase:

This routine drives the next phase of the motor.

Click on the code line just after this to set the cursor position. Thisline
has the instruction:

br MainLoop;
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To set the breakpoint here click the * Toggle Breakpoint’ tool bar button:
The ‘Toggle Breakpoint’ icon

Lines on which breakpoints are set are shown inred. Clicking the
breakpoint icon toggles the breakpoint at the cursor position on or off.

Once we have set the breakpoint we need to turn on trace buffering so that
on reaching the breakpoint we will be able to step backwards and check
the previous program actions.

Activating trace buffering

To activate the trace buffer, select ‘ Debug’ from the *Options’ menu and
click the *Enabled’ check box for the trace buffer. Micropak 75XL alows
the size of the trace buffer to be adjusted, but the default size will be
suitable for us here.

Running to the breakpoint

Now we have set the breakpoint and activated the trace buffer we can run
the code again (the * Go/Stop’ tool bar button is probably the easiest way).
When the breakpoint is reached execution is halted, a message appears
and a beep is heard.

Y ou will notice that the yellow line indicating the PC marker is now on
our chosen instruction, and that a new pattern will just have been driven
out.

Checking the individual drive patterns

Y ou should now restart the execution using the ‘Go’ tool bar button or by
selecting ‘Go’ from the ‘Debug’ menu. Correct patterns should activate
one output or two outputs simultaneously. |If the current state of the phase
outputs shown in the panel window currently has all outputs activated, the
erroneous pattern must have been driven out. If the current pattern
appears correct (i.e. it has one or two outputs active), then you can run to
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the next pattern by using the ‘Go’ tool bar button again. Continue this
process until the faulty pattern has just been driven out.

At this stage we know that the pattern just output was wrong. Examining
the code shows that the pattern is written to the data item ‘ MotorPort’
from vaues derived in ‘NewPhase’.

The statementsin ‘NewPhase' contain each of the specific patterns written
to the data item ‘MotorPort’. In order to know which of the phases set the
faulty pattern we need to know which lines were run just prior to the
hardware updating.

The ‘Backstep’ facility allows usto ‘turn the clock back’ and effectively
run the code in reverse, tracing the flow of execution back up through the
code.

To invoke this facility select ‘ Step Back Into’ from the ‘ Trace’ menu.

Using this facility you will find that the following statement was the
villain:
Phase3Test:
mov b,#1111b

The pattern in question is specified here as a binary constant (1111B) and
it can now be seen that this does indeed set all lines active. In fact this
value should be (0100B). Having located the bug we can now move on to
see how to make an appropriate correction.

Making corrections

To correct this bug you can use the text editing facilities of Micropak
75XL directly.

Position the cursor in the faulty line and make the correction using the
cursor keys and overtyping, etc. After editing you must then save the file.
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Re-running after corrections

Y ou must now rebuild the project to ensure that the corrections are
included in the simulation. To do this select *Rebuild All" from the
‘Project’” menu or use the tool bar button described earlier.

The 75X tool chain will automatically be invoked and a new executable
filewill be generated. Once the rebuild process has finished, the project
fileswill be re-loaded.

Y ou should now be able to re-run the code (e.g. by clicking the‘Go’ tool
bar button), and this time the phase output sequence should be correct.

Moving on

Having been through this tutorial session you should have some idea of the
facilities which Micropak 75XL offers, and how these can be used to good
advantage in your own testing or development programme.

The later sections of this guide provide reference information covering all
the various facilities in more detail.

Perhaps before leaving the tutorial set up, you might find it helpful to use
the context of the tutorial example to experiment with some of the other
facilities described in later sections. Here are some suggestions:

Step over - to skip over, say, the button testing routines.

Step out - single step into the * NewPhase' routine and then
use the ‘ Step Out’ command to run to the end of this routine.
Thisfacility is one of the most useful when investigating code
so it’s beneficial to learn how to use it early on.

Watch windows - Micropak 75XL provides various ways of
viewing variables. Try adding some dataitemsto awatch
window to show the interphase counter (‘ Count’) and the tick
recording variable (' TimerTick’).
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Tutorial

Trace buffering - enable the trace buffer for awhile, observe
the effect on speed, then use the * Backstep’ facilities to watch
the code running in reverse. Note that the PC is shown in
green.

Port views - ports can be viewed 4 lines at atime. Showing
port O in this way would be a good example of the use of this
facility.

Breakpoints - usethe ‘Breakpoints command to set a
breakpoint at the code line which deals with the ‘ Start’ button
being detected as active, then run the code, activate the button
and seeif the breakpoint is correctly reached.

Source editing - try some of the editor functions available on
the ‘Edit’ menu.

Y ou will probably find most of these functions can be invoked easily using
the menu system. However, if you need more explanation or information,
try the on-line help facility, or the later sections of this manual.
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User Interface Details

The Micropak 75XL screen
When the Micropak 75XL program is started the following window is
displayed:

Menu Bar Tool Bar

Micropak 75XL : TUTORIAL.BAT
File Edit Yiew Project TeSt Debug Trace Optighs Window Help

BEOEEaAEBEEE=E

|Far Help, prass Fi § |uPD753012 | | MUK | |

Status Bar
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The Micropak 75XL screen User Interface Details

The main user interface e ements are as follows:

Name Description
Menu Bar Lists the available menus, e.g.:
File Edit Yiew Project
Menu When amenu is selected it lists the commands specific to that
menu, e.g.:
I Trace Options Wi
Go Fb
Step Into Fb
Step Over F7
Step Out F8
Note that when a menu option is not available it is displayed
‘greyed out’ and cannot be selected.
Tool Bar The tool bar displays a number of buttons which provide quick
access to some of the menu commands e.g.:
REE
Desktop Thisis the background area of the screen.
Icon This displays awindow in a compact form, e.g.:
Port P&
Window This displays source code, help information, simulated objects
etc., eg.:
= () * | -
CLOM3:
CLOM1-0:
CPU E
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Name Description

Scroll Bars  These change the position within afile or list, e.g.:

[e] ] [+]

Status Bar This displays information about your current session,
including processor type, position within afile, etc., e.g.:

uPD753012 | [ [NUM [00012 007 ||

Window elements
Close box Maximise button

Title bar K Minimise button
I R - |
o

»

PageUparea ——— |

_/
a \_ Border

Vertical scroll bar
Scroll Button _
Page Downarea ——— |

Horizontal scroll bar

o | ol »

k Border
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User Interface Details

Name

Description

Window border

Window title

Close button

Minimise button

Maximise button

Restore button

Scroll Up arrow

Scroll Down arrow

Page Up area
Page Down area

Scroll button

Used to size the window by dragging with the mouse

Indicates the window contents. Also used for moving
the window by clicking and dragging

Closes the window when double-clicked, e.g.:

=]

Reduces the window to an icon when clicked, e.g.:

-]

Enlarges the window to its maximum size when
clicked, e.g.:

[=

Restores the window to its original size when clicked
with the mouse, e.g.:

2]

Click once with the mouse to scroll up oneline at a
time, e.g.:

[+]

Click once with the mouse to scroll down oneline at a
time, e.g.:

Scrolls up one page at a time when clicked once
Scrolls down one page at atime when clicked once

Indicates the relative position in the file/list. Drag
with the mouse to change position in the file/list
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Menu operation

Menus can be invoked either by the appropriate keyboard actions or by
clicking with the mouse. Menu options are grouped under main headings
in amenu bar located across the top of the window.

Clicking on one of the options in the menu bar will cause the appropriate
pull-down menu to be displayed, e.g.:

= Open File
File Name: Directones:
|m | c:\mpakimp 75xl
o - o ]
[= mpak
B mp75w
*
+
Lizst Files of Type: Drives:
|Assemhler [*.asm) |£I | = c: ms-dos_B |£I

The options presented can then be selected by moving the mouse cursor to
the desired option and clicking again. Note that menu options which are
not relevant to the current operation are shown ‘greyed out’.

Sub-menu options normally have a single character underlined. If the
associated key is pressed whilst holding down the Alt key the appropriate
sub-menu will be displayed. This provides an alternative to using the
mouse to display the desired sub-menu.

In addition to this underlined character, some menu options also include a
short cut key or accelerator key which can be used to invoke a function
directly. These are described to the right of the menu text, e.g.: using the
combination of the Ctrl and ‘D’ key will display the * Device Window’.

Menu options which, when selected, display dialog boxes are shown with
‘..." a the end of the option field, e.g.:

Open...
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User Interface Details

Menu function reference descriptions

The following tables show how the functions accessed via the menu

system are grouped:
File Edit View Project Test
New Undo Line New Open
Open Redo Next Error Open Save As
Close Cut Previous Error Edit Run Script
Save Copy Toggle Bookmark |Close Stop Script
Save As Paste Next Bookmark Assemble File Stop All Scripts
Delete Previous Bookmark |Link New Panel
Print Find Clear All Rebuild All Show Panel
Bookmarks Palette
Print Preview Replace Toolbar Stop Build Panel
Properties
Print Setup Read Only Status Bar Recent Projects Panel Grid
Setting
Exit Syntax Colouring Recent Tests
Recent Files
Debug Trace Options Window Help
Go Go Back Project New Window Micropak
Workbench
Step Into Step Back Into Debug Cascade Build Tools
Step Over Step Back Over Editor Tile About Micropak
75XL
Step Out Step Back Out Arrange Icons
Step to Cursor |Step Back to Stack Source
Cursor Windows
Go and Go Clear Timing Timing
Interval
Stop Debugging |New Signals Watch
Reset Edit Signals Registers
Set PC to SignalsZoom In Output
Cursor
Breakpoints Signals Zoom Out Device
QuickWatch Snap Signals Pin

Add Watch Item

Open Windows
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Menu : ‘File’

This group of menu options deals with file handling and printing,
including creating a new panel. Notethat alist of the four most recently
used filesis maintained for convenience. The exit command for the
Micropak 75XL program is also accessed from this menu.

Option Description

New Start anew file

Open... Open an existing file

Close Close a currently open file

Save Update the disk copy of the current file

Save As... Write the current file to disk, optionally with a different name
Print... Print the current file

Print Preview See on screen how the current file will appear when printed
Print Setup... Review printing options

Exit Leave the Micropak 75XL program

Recent Files Open arecently accessed file

Menu : ‘Edit’

This group of menu options deals with the editing of files. Any text file
may be edited using these functions. If afile has not been opened prior to
editing, an ‘untitled’ file will be created which may be saved later. See
the *Options' menu for options relating to this menu.

Option Description

Undo Undo the most recent editing action

Redo Redo the most current editing action

Cut Remove the selected text from the current file/list and
placein the clipboard

Copy Copy the selected text to the clipboard

Paste Insert the current clipboard contents

Delete Delete the selected text from the current file or list

Find Find a string of charactersin the current file.

Replace Find and replace a string of text with another

Read Only Mark the current file as read only
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Menu : ‘View’

This menu deals with viewing the main windows and the listing window.
Facilities are provided to place bookmarks and to fold and unfold text in
thelisting file. Seethe‘Options' menu for options relating to this listing

display.

Option Description

Line Go to aline number

Next Error Go to the source line containing the next error
Previous Error Go to the source line containing the previous error
Toggle Bookmark Turn a bookmark on/off

Next Bookmark Move to the next bookmark

Previous Bookmark Move to the previous bookmark

Clear All Bookmarks  Clear al the defined bookmarks

Tool Bar Turn the tool bar on and off

Status Bar Turn the status bar on and off

Syntax Colouring Enable or disable syntax colouring

Menu : ‘Project’

This group of menu options deals with project-wide facilities. This
includes project context files, script files and rebuilding the executable
file. Seethe'Options menu for options relating to this menu.

Option Description

New Create anew project file

Open Open an existing project file

Edit Add or delete files listed for the project
Close Close the current project file

Assemble File Assemble an individual sourcefile

Link Link the object files in the current project
Rebuild All Rebuild a project from scratch

Stop Build Stop the current project rebuild

Recent Projects Load arecently accessed project
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Menu : ‘Test’

This group of menu options handles the test script files and test panels.

Option Description

Open Open atest file

Save As Save the current window positions and debug options as
anew test file

Run Script Run the selected script file

Stop Script Stop execution of the selected script file

Stop All Scripts Stop execution of all script files

New Panel Create a new panel

Show Panel Palette

Panel Properties
Panel Grid Settings
Recent Tests

Menu : ‘Debug’

Display the panel palette, allowing you to add and edit
items

Specify the properties of atest panel item

Specify the grid settings in the test panel window
Display the four most recently opened test files

This group of menu options controls the running of the program when
debugging. It contains various run modes and allows breakpoints to be
set. Seethe ‘Options’ menu for options relating to this menu.

Option Description

Go Run the target processor

Step Into Run a single instruction

Step Over Run a single instruction or procedure

Step Out Run to areturn

Step to Cursor Run until the cursor position is reached

Go and Go Run until breakpoint is reached and run again

Stop Debugging
Reset

Set PC to Cursor
Breakpoints
QuickWatch
Add Watch Item

Halt the target processor

Generate a ‘reset’ in the target processor
Set the PC to the current cursor position

Set breakpoints

Inspect the value of the selected variable
Select an item and add to the watch window
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Menu: ‘Trace’

This group of menu options controls the trace buffer facilities and the
signal plot display facilities. This menu also includes the facility to clear

the timing counter.

Option

Description

Go Back

Step Back Into
Step Back Over
Step Back Out
Step Back to Cursor
Clear Timing
New Signals

Edit Signals
Signals Zoom In
Signals Zoom Out
Snap Signals

Menu: ‘Options’

Trace back to start of the buffer

Step back one instruction

Step back one instruction or procedure
Step back to start of the procedure

Step back to the current cursor position
Clear the timing interval counter

Create anew signal box

Edit asignal box

Magnify the signal box

Reduce the contents of the signal box trace
Snap signal display to nearest value transition

This group of menu options allows the user to specify options which
control other menu facilities.

Option Description

Project Change project rebuild options for the pre-processors
assembler and linker

Debug Change options for the debug menu including trace
buffer on/off setting

Editor Specify the options for the editor
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Menu: ‘Window’

This group of menu options allows the user to specify new windows to be
displayed and rearrange existing windows.

Option Description

New Window Generate anew ‘copy’ of the current window
Cascade Arrange all the open windows in a‘cascaded’ display
Tile Arrange all the open windows as ‘tiles

Arrange Icons

Stack Source
Windows

Timing

Watch
Register
Output

Device

Pin

Open Windows

Tidy the display of theicons
Stack al the open source windows

Open the timing window

Open the watch window

Open the register window

Open the output window

Open a new device window including RAM and Ports
Open a pin window

Shows alist of currently open windows

Menu: ‘Help’
This group of menu options gives the user access to the help facilities.
Option Description
Micropak Display help specific to Micropak 75XL
Workbench
Build Tools Display error and option information for the build tools

About Micropak
75XL

Display version and copyright information
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Using dialog boxes

Dialog boxes are used to enter values and make selections. Menu options
which invoke dialog boxes are shown with ... adjacent to the menu text,

eg.

Open...

Examples of dialog boxes which are specific to Micropak 75XL are shown
in the relevant section. Common dialog boxes such as those for opening
filesfollow standard conventions. An exampleis given here:

= Open File
File Name: Directones:
|m | c:\mpakimp 75xl
o - o ]
[= mpak
B mp75w
*
+
Lizst Files of Type: Drives:
|Assemhler [*.asm) |£I | = c: ms-dos_B |£I

In order to enter avalue into afield within a dialog box you will need to
click into the field using the mouse. The text cursor will then appear in
thisfield, indicating where the text you type will appear. The following
keys can be used within dialog boxes with their normal editing functions:

Key Function

Ins Toggle in and out of insert mode

Del Delete the character to the right of the cursor
Left, Right, Up or Non destructive cursor movement

Down Arrow

Tab Move to the next field on the window
Backspace Delete the character to the left of the cursor
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List boxes

These are special fields which allow the selection of one item from alist,
and incorporate an arrowed button alongside enabling you to ‘pick and
choose' from the displayed choices, e.g.:

Fast *
Slow

Radio buttons

Again, special fields, called ‘radio buttons’ require you choose between
several choices displayed on the screen by clicking with the mouse in the
circular areato the left of the field text, e.g.:

) Insert Spaces

Check boxes

These fields enable you select or deselect an option by clicking the box
with the mouse, e.g.: .:

| Hurign[l_tal
R

Keyboard actions

Micropak 75XL includes a set of pre-defined ‘accelerator’ key functions.
These allow fast access to the most commonly used menu options. Where
key functions exist they are listed alongside the menu options. A full
listing of these is given in the ‘Keyboard Summary’ chapter.
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The tool bar

The tool bar provides a quick and easy way to access many of the most
frequently used functions and consists of arow of buttons, each with an
icon representing the action which will be performed when the button is

clicked using the mouse.
The tool bar icons

Open Document
Save Document

Cut Selected Text
To Clipboard

Copy Sedlected
Text To
Clipboard

Paste Contents Of
Clipboard

Find/Replace
Next

Assemble File

B HEE

= BN € E e

Link
Rebuild All
Project
Execute/Stop Test
Script

Go/Stop

% -
Eﬂgﬂﬁﬁlﬂﬂ 7 EEE

Step Into
Step Over
Step Out

Step To Cursor

Reset Processor
Set PC to Cursor

Toggle Breakpoint
at Cursor

Quickwatch

Clear Interval

Fast/Slow Debug
Mode

Open Device
Window

Open Pin Window
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Using the on-line help system

Micropak 75XL includes an on-line context sensitive help facility which
can beinvoked using any of the following methods:

Pressing the F1 function key
Using the Help pull-down menu
Pressing the Help button on the dialog boxes
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Navigating Project Files

Project file overview

Micropak 75XL requires files to be organised by project. This section
describes the assumed file grouping and explains how Micropak 75XL
uses the various files involved.

Project files

There are a number of files, each having a specific function, which
collectively congtitute a project. These files are as follows:

.BAT Batch file used to control project rebuilding

.PRJ Project information file

TST Window configuration details

P File containing code and debugging information from

the listing converter

Projects files are identified by the *.BAT’ extension and are opened by
selecting ‘Open’ from the ‘Project’” menu in order to set up atest
environment. Please be aware that opening the project file does not
automatically run script files. The source assembler file will however be
opened automatically, ready for editing or actioning.

The project file is atext file and can be edited directly. It can be usedin
one of two ways.

Firstly, if the project is ‘internal’ the batch file will contain just the text
‘REM MicroPak generated batch file - Do Not Modify.” Thiswill allow
Micropak 75XL to handle all the project rebuilding, allowing the user to
add and delete source files and select from a comprehensive range of
options. If you intend to use this ‘internal’ project rebuilding facility then
do not delete or change the contents of thisfile.
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The second way in which the project batch file may be used is for
‘externa’ project rebuilding. If thisoption is desired, smply placein this
file all the commands required for the project rebuilding sequence. Note
that Micropak 75XL does not perform any checking of the contents of this
batch file - it will ssimply execute whatever commands are placed within it.

Source files are required for rebuilding

Micropak 75XL does not require the original assembler source filesin
order to execute code. However, it does require them in order to allow you
to edit the source and to subsequently rebuild the executable file. It also
requires the source file to enable debugging to take place.

Source files are text files and can be edited using the Micropak 75XL
editing functions. They are expected to have the extension ‘. ASM’.

The project information file

The project information file must be present within the project
environment. It has the same name as the project but has a .PRJfile
extension, e.g. ‘PROJECT1.PRJ. For both types of project (i.e. ‘internal’
and ‘externa’) this file defines the processor type selected and the clock
frequencies. In addition, for internal projects, this file also contains
details of the source files and associated options.

The window configuration file

The window configuration file details your test environment in terms of
window position information, breakpoints, watch item names, etc. It
avoids the need to redefine your testing environment each time you start a
new testing session. The file has the same name as the project but has a
.TST file extension, e.g. ‘PROJECTL.TST".

The debug information file

Thisfile, with a.P file extension, holds the source code to be executed
plus the debug information which is output from the listing converter.
Thisfileis created as aresult of the build process and normally uses the
same name as the rest of the project, e.g. ‘PROJECT1.P.
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Opening a project

A project is opened by selecting ‘Open’ from the ‘ Project’ menu. A dialog
box similar to the following is displayed: An exampleis given here:

= Open Project
File Hame: Directories:
|m | cimpakimp 75zl
valbat g & o
walext_bat = mpak
B> mp754
+
+
List Files of Type: Drives:
Froject Files [~.bat) [2] [=c:msdoss (]

Browse through your drives and directories until the correct project batch
fileislocated, select it, then click the”OK’ button.

The appropriate assembler file (with a.ASM extension) will be loaded and
displayed within awindow on the ‘ desktop space’ of Micropak 75XL.

Further files (such as source files, other assembler files and script files)
may be opened by selecting ‘Open’ from the ‘File’ menu. The following
window is displayed, allowing you to select the file required:

= Open File
File Hame: Directories:
|m | c:impakimp75xl
val.asm + = e\ +*
[ mpak
£ mo75
+
+
List Files of Type: Drives:
Aszembler [*_asm] |£I | = c: ms-dos_b |£I
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Editing a project

Micropak 75XL includes the facility to alow you to add and remove
entries from the list of files which comprise a project. If the ‘Edit’ option
is selected from the * Project’ menu the following window is displayed: :

—_ Edit Project
File Hame: Directories:
c:impakimp 75Hxl
fem
val asm = o\ +*
= mpak
B mpi5w
+
List Filez of Type: Drives:
Aszzembler [*.asm] |£I | c: mz-doz_bG |£I
Files in Project: I Add I
c:impakimp75xlival asm
Add All
Prandunber

To add afileto thelist of files within the project, click the ‘List Files of
Type' list box and select the type of file to be added from the displayed
list:

Azzembler [*.

Macro [*.mac] -
Structured [*.src:™ =)
Header [*.inc*.h]

Listing [=.prn]

Map [*.map]

Symbol [*.sym] u

Browse the directory structure to locate the file then click the * Add’
button. If you wish to add all files from the currently selected directory to
thelist, click the *Add All’ button.

To remove afile from the list of filesin the project select it, then click the
‘Delete’ button.
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Specify Project Options

For both internal and external projects there are a number of options
which you can specify, including processor type, build mode and
command strings for rebuilding the project. The project options are
specified by selecting ‘Project’ from the ‘Options' menu and Micropak
75XL will display the correct dialog box according to the type of project.
As the options associated with the two types of project differ, each is
detailed separately below.

Internal project options

When ‘Project’ is selected from the * Options' menu the following dialog
box is displayed:

Build Mode " Build Dphions | [1].4 I

@ Debug;

O Relose [_Cancel |
Help I

| Structured Assembler Preprocessor. ..

| Macro Processor. ..

Assembler__.

Linker...

Object Converter. ..

|
|
|
5 Bun List Converter

Processor:

[uPD753012 |*]

The ‘Build Mode' radio button allows you to specify whether the
executable file should be a debug type or arelease type.

The ‘Processor’ list box contains the processor type for which the project
isbeing built. Note that thisis not required for the rebuilding process but
for creating the processor in the smulation. If the processor typeis
changed it is necessary to reload or rebuild the project before the change
will take effect.
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Options for the Assembler and Linker are specified by clicking the
appropriate button to display a dialog box from which the settings for the
appropriate tool can be viewed and changed as required. As an example,
when the Assembler button is pressed a dialog box similar to the following
is displayed:

= Assembler Options
Build Options: @ Debug Specific ' Release Specific ! Common to Both

Optionz String:
-LT& -M1 -MKS -KA -0 -NJ -E -NKX -G -P -C3012 L Cancel I

+| | Use Project Defaults I

Assembler Target Product [-C]: [ Create Assembly List File [-P/-NP]
Page Length [-LL]: I:I [ Create Error List File [—I_EJ'-NE]
| Output Symbol Table List [-K5/-NKS]

Page Width [-LW]: |:| B Dutput Assembly List to Print File [-KA/-NKA]

] Force DObject File Creation [-J/-NJ]

Switching Mode [-M]: m N
9= el [ Create Debug Information [-G/-NG]
Tab Width [-LT]: [ Cross Reference List [-KX/-NEX]

Include Files Path [-1]: | |

Other Options: | |

The *Build Options' radio button indicates to which build mode the
options are relevant.

The *Options String’ is a non-editable text box which displays the options
as they would appear if entered at the DOS command line.

Note that the options will only take effect when the ‘OK’ button is
pressed.
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External project options

When ‘Project’ is selected from the *Options’ menu (and the project is an
externa type) the following dialog box is displayed:

= External Project Options

Target Hame: Build Mode
c::‘tmpak‘tmp?ﬁxl"waleut.heu | @ Debug

Processor: ) Release | Cancel

|uPD 750004 B

Debug Build: |c:‘umpak‘tmp?ﬁxl‘walext.hat
Release Build: |c:‘umpak‘ump?ﬁxl‘walext.hat

The ‘Target Name' is the name of the debug or release executable file and
is, by default, assumed to be the batch file name with a .ABS extension.

The *Processor’ list box allows you to select the type of processor for
which the project is being built. Thisis not required for the rebuild
process but is necessary for creating the processor for the simulation. 1f
the processor type is changed a project reload or rebuild is required before
the change will take effect.

The ‘Build Mode' radio button allows you to specify whether the
executable should be a debug type or arelease type.

The ‘Debug Build' field allows you to specify the DOS command string
required to rebuild the debug version of the project. The nameis, by
default, assumed to be same as the batch file.

The ‘Release Build' field allows you to specify the DOS command string
required to rebuild the release version of the project. The nameis, by
default, assumed to be same as the batch file.
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Using the Editor

Micropak 75XL alows text files to be displayed and edited.

Opening files

The normal method for opening anew fileis by selecting ‘Open’ from the
‘File’ menu. ‘Shortcut’ methods are also available using the accelerator
function keys or by clicking the following button on the tool bar:

The following dialog box is displayed:

= Open File
File Hame: Directories:
|m | c:impakimp75xl
val.asm + = e\ +*
[ mpak
£ mo75
+
+
List Files of Type: Drives:
Aszembler [*_asm] |£I | = c: ms-dos_b |£I
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L ocate the desired file by selecting the required drive and directory and
selecting from the list of files. Note that only files of a specific type will
be displayed, according to the value selected from the ‘List files of type’

field, e.g.:

File specification

File type

*.asm
*.8rc,*.s
*.mac
*.prn
*.bat
*.sCcr
*.pan

* *

File defaults

Assembler files
Structured assembler files
Macro processor files
Listing files

Batch files

Script files

Panel files

All files

In addition to the above file types the following extensions are assumed

defaults:

File extension File type

*.bat Project batch file

*.tst Project context files (not text files)

*p Absolute assembler list file
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Syntax colouring

Asan aid to entering and colouring 75X family source code a syntax
colouring facility is provided. This colours the various elements of code as
follows:

Element Colour
Mnenomics and operators blue
Comments green
Pseudo mnenomics red
Other black

Syntax colouring can be enabled by selecting ‘ Syntax Colouring’ from the
‘View’ menu. Note that syntax colouring is only available for source
files.

Mouse driven functions when editing

The text cursor can be set anywhere simply my clicking with the left
mouse button.

Selecting areas of text

Areas of text can be selected by dragging the text cursor from the
beginning of the required areato the end of it. Text blocks selected in this
way will be shown as white on black. Selected blocks of text are
automatically copied to the *find’ string whenever the ‘Find' or ‘ Replace’
dialog boxes are opened.

The double-click

If the left mouse button is double-clicked whilst the text cursor is
positioned within aword, it will be selected and editing will now bein
word mode.
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The triple-click

If the left mouse button is triple-clicked whilst the text cursor is positioned
within aline, the text within that line will be selected and editing will
change automatically to line mode.

The shifted left hand click

If the left mouse button is clicked whilst the Shift key is pressed, the text
between the current text cursor position and the current mouse cursor
position will be selected.

When the editor isin word or line mode, the selected area of text will
include that previously selected by double-clicking or triple-clicking.

Editing possibilities
Once an area of text has been selected it can be:
Deleted (Del)
Removed from the file and placed in the clipboard (Cut)
Copied to the clipboard (Copy)
Pasted from the clipboard to another position (Paste)

These functions can be invoked via the ‘ Edit’ menu or by using the
appropriate keyboard accelerator shortcuts.

Editor options

Editor options are set by selecting ‘ Editor’ from the ‘Options’ menu. The
following dialog box is displayed:

= Editor Options
Tab Settingz— | [ Scroll Bars
Tab Stops: IEI <] Horizontal
(<] Vertical
()] Keep Tabs

) Insert Spaces Help I
Undo Buffer Size [K Bytes]: l:l
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The tab spacing can be changed to any number between 1 and 62. The
default number is 8 characters.

The horizontal and vertical scroll bars can be desel ected independently by
clicking the appropriate check box, e.g.:

| Yertical

The ‘Undo’ buffer is used to store editor commands and associated text in
order to enable actions to be subsequently undone by the ‘Undo’
command. The size of this buffer may be set between 0 Kbytes and 31
Kbytes.
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Keyboard functions when editing

Basic text editing is performed by positioning the text cursor and using the
standard editing keys and functions. The position of the text cursor is set
using the cursor keys or by clicking with the left mouse button.

The standard editing keys and functions are as follows:

Key Function

Ins Toggle between insert and overwrite mode
Del Delete character to right of cursor or previously selected block
Backspace Delete character to left of cursor
Home Skip to beginning of line

End Skip to end of line

PgUp Move one page up

PgDn Move one page down

Left Cursor one character |eft

Right Cursor one character right

Up Cursor one character up

Down Cursor one character down
Ctrl-Ins Copy to clipboard

Ctrl-Left Move one word left

Ctrl-Right Move one word right

Ctrl-Up Scroll window up one line
Ctrl-Down Scroll window down one line
Ctrl-PgUp Scroll left one page

Ctrl-PgDn Scroll right one page

Ctrl-Home Skip to start of file

Ctrl-End Skip to end of file

Shift-Del Copy to clipboard and delete line
Shift-Ins Copy from clipboard

Ctrl-Z Undo

Ctrl-X Cut

Ctrl-C Copy

Ctrl-v Paste

Return Insert new line
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Locating and changing text

The following facilities are available for locating and, optionally,
changing specific text within afile:

Facility Function

Find Locate a specified string of characters

Replace Locate a specified string of characters and optionally replace
it with a different string

Bookmarks Set, clear and move between markers set in the text

Find

Thisis selected from the ‘ Edit’ menu. The following dialog box is
displayed:

Find What: | | | Bes |

] Match Whole Word Only Ditection—
[] Match Case O'Up @ Down

Type the string of characters to be located in the * Find What:’ field.

If the entire string is to be matched select the following check box:

B iMatch Whole Word Only:

If the case of the string of charactersis to be matched select the following
check box:

B Match Case

The direction of the search within the file can be specified using the
following radio buttons:

Direction
’7@' Up @ Down
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Replace
Thisis selected from the ‘ Edit’ menu. The following dialog box is

displayed:
Find What: || | o o I

Replace With: | |

Frapians 43

[] Match Whole Word Only

Cancel

[] Match LCasze

Type the string of characters to be located in the ‘Find What:’ field. Type
the replacement string of charactersin the ‘ Replace With:’ field.

If the entire string is to be matched select the following check box:

B iMatch Whole Word Only:

If the case of the string of charactersis to be matched select the following
check box:

B Match Case

To locate next instance of the string to be replaced click the following
button:

Find Next

To replace the first occurrence of the character string click the following

o
c
=
o
=2

Replace

To replace al occurrences of the character string click the following

o
<
=

Io
=2

Replace All

~
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Bookmarks

To set abookmark, position the text cursor on the line to be marked and
select ‘ Toggle Bookmark’ from the *View’ menu. To subsequently
remove a bookmark first locate it and then select the same menu option.

To move to the next bookmark in the file select ‘ Next Bookmark’ from the

‘View' menu.
To move to the previous bookmark in the file select * Previous Bookmark’
from the ‘View’ menu.

Note that these menu options have corresponding ‘ accelerator’ key
Sequences.

To remove al bookmarks in the current file select ‘ Clear All Bookmarks'
from the ‘View’ menu.

The implications of editing

When any relevant source areas are edited, the relationship between the
object and source is atered and the object file no longer corresponds
exactly to the source files. Therefore, the assembler or other relevant tool
should be re-invoked to re-build the object file from the source file.
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Re-building the project

The assembler can be re-invoked to re-build the object file from the source
file either by selecting ‘Rebuild All” from the ‘ Project’ menu. Thereis
also atools available on the tool bar for this command, i.e.:

‘Rebuild All Project’:

When the tool is re-invoked the re-build process will run and its output
will be displayed in the output window. This will include any errors
encountered by the tool chain including pre-processor errors, assembler
errors and linker errors.

When the process is complete the output window should be examined for
errors before continuing. On closing the output window, Micropak 75XL
will read the new source and object files and redraw the display.

Please note that the rebuilding process will operate on the disk stored
versions of the source files. If the editor has been used and the file not
stored a message will be displayed asking if you wish to continue with the
rebuild. To include the edited version of the file in the build you must
reply no to the message, store the edited version of the file on the disk and
then re-invoke the build.

The re-assembly mechanism

This mechanism relies on the project sequence file and a number of
related files being set up correctly, which is discussed in more detail in the
‘Navigating Project Files' chapter of this user manual.

Y ou should also ensure that the 75XL tool chainis correctly installed on
the machine and that a‘DOS' ‘PATH’ has been set so that the tools can

be located. Note that the ‘DOS' ‘PATH’ must be set before “WINDOWS
isinvoked.

Correcting errors flagged by the assembler

Any errors found are flagged. There will be ‘Next’ and ‘ Previous' menu
items enabling you to locate each error, and double-clicking on an error in
the output window will take you to the appropriate line in the sourcefile.
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Controlling Execution

Overview

There are various ways in which the 75X code loaded into the simulated
system can be executed, such as single step, multi-step and so on. Before
describing each of these in detail let us consider some general aspects of
execution, such as how to stop the processor when it is running and the
factors which affect execution speed and how they can be optimised.

Ceasing execution

Execution can always be interrupted by pressing the appropriate function
key, selecting ‘ Stop Debugging’ from the ‘Debug’ menu or clicking the
following tool bar icon:

Optimising execution speed

Updating view items on-screen slows the simulation, as do complex
breakpoints. To get the optimum execution speed you should restrict the
view items that are visible on-screen and reduce the number of active
breakpoints to a minimum.

The first of these options can be achieved by ‘minimising’ any windows
which are not currently being monitored by clicking the respective
minimise button:

-]

Note that the source listing file may aso be minimised.

Breakpoints can be reduced by disabling those which are not required for
the current test.
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Execution possibilities

The code can be run in Micropak 75XL in the following way:
Go (i.e. run until breakpoint is reached)
Go and Go (report breakpoints but don't stop)

Step into
Step over
Step to cursor
Step out
Tools for the following actions are available on the tool bar:
Go: Step into: Step over: Step to Step out:
Cursor:

W [ I

Simple execution and debugging modes

This option allows execution to continue until a breakpoint is reached, or
until execution is halted. Two modes of operation are possible: * Slow’ and
‘Fast’. The mode is specified by selecting ‘ Debug Options' from the
‘Options’ menu. The following dialog box is displayed:

= Debug Options
Llife E [ Trace Buffer— |
Signal Update [sl: |1_e-003 [ Enables
Increment [s): 1_e-00E Size 5k |1.e-003

Script File Commands [~ Signal Buffer

M aximum: [] Enabled
in Time [s] Size [s):

Select from *Slow’ or ‘Fast’ inthe ‘Mode' field of this dialog box.
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‘Slow’ mode will show you multi-step animation of the code, updating all
windows and showing the progression of the PC through the listing
window after each instruction is executed. ‘ Fast’ mode will only update
the test panels and the animated PC will not be shown.

The modes of operation may a so be specified by clicking the mode icon
on the tool bar, which toggles between ‘Fast’ and ‘ Slow’ modes:

‘Fast” mode: ‘Slow’ mode:

Single stepping - Step into
Clicking the ‘ Single step’ icon or pressing the appropriate function key
will cause the execution of the target code pointed to by the current PC.
Single stepping - Step over

This option, similar to * Step into’, will execute one instruction or all
instructions within a single procedure, if the statement pointed to by the
PC isacall to aprocedure.

Step out

Thiswill run to the first RET instruction which occurs with the stack at
the current level. Thisis provided as afast way of running to the end of a
subroutine once the code in an area under investigation has been stepped
through. The stack level condition impliesit will ignore any subroutine/
return combinations encountered on route.

Step to cursor

This allows the code to run until execution reaches the line in the source
listing window where the cursor is placed.

To use this function, first set the cursor by clicking within the desired line.
The function can then be invoked by pressing the appropriate function key
or clicking the * Step to cursor’ icon on the toolbar.

Go and Go

Thisfacility is provided for batch testing. Here the code is run reporting
and updating the display as and when a breakpoint is reached.
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Resetting and viewing the processor clock

The processor may be reset by selecting ‘Reset’ from the ‘ Debug’ menu.
The following confirmation box will be displayed to ensure that the
processor is not reset accidentally:

= Micropak 75¥L

9 Are you sure you want to reset?

A reset generated in this way will set the processor back to a clock value of
‘0’ and al the normal processor actions expected at reset will occur.

The processor clock may be viewed in a device window by selecting
‘Device’ from the ‘“Window’ menu and choosing from the list.

The program counter

Micropak 75XL keeps control of execution through the program counter
(PC). Thisisupdated whenever a statement is run.

The current position of the PC is seen in the source listing window as a
yellow bar. It can aso be viewed by selecting ‘Device' from the *Window’
menu and clicking the * Program Counter’ option. The following dialog
box will be displayed:

The PC can be set using this dialog box or by choosing ‘ Set PC to cursor’
from the ‘Debug’ menu, which sets the PC to the ROM address currently
being pointed to by the cursor.
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The timing window

An interval window can be selected for display by selecting ‘ Timing' from
the “Window’ menu. The following dialog box is displayed:

= - | a

Time [us]: (FEEER
Ins. Cyecle: (gpo7zg

Interval

Time [us]:
Inz. Cycle: ICI

Theinterval values will be incremented with each successive execution.
The interval value may be reset by selecting ‘ Clear Timing Interval’ from
the ‘ Trace’ menu.

Debug options

A number of user configurable options are available by choosing ‘ Debug’
from the ‘Options' menu. The following dialog box will be displayed:

= Debug Options
Mode: E [ Trace Buffer — |

Signal Update (s} |1_e-003 D Enable: r—
Increment [s): 1.¢-006 Size [5): |1.e-003

Script File Commands [~ Signal Buffer

M azximum: [] Enabled
in Time [s): Size [s):

Mode

Fast This run mode allows simulation execution at full
speed. Only the test panels are updated.

Slow When this run mode is selected all activated windows

will be updated after each instruction is executed.
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Signal window control

Signal Update(s) A vaue of simulated time in seconds may be input.
This value specifies the time interval between each
signal window update.

Increment(s) Again, avalue of simulated time in seconds may be
input. This value will be used when thereisno
activity in the system and the CPU isin either HALT
or STOP mode. In thisinstance the value will be used
to increment the clock and thus accelerate the
simulation.

Script file commands

Thisfacility is provided to allow the simulator to trap script file loops.
Two parameters are used:

Maximum Here the user specifies the maximum number of script
instructions to be executed in a given time.

in-Time(s) The user specifies the time limit.

If the number of commands executed within the time specified reaches the
maximum specified awarning is given.

Trace buffer control
Enabler Check box for enabling or disabling trace buffering.

Size(s) The user can specify the size of the trace buffer which
is expressed as simulated time, in seconds.

Signal buffer control
Enabled Check box for enabling or disabling signal capture.

Size(s) The user can specify the size of the signal buffer which
is expressed as simulated time, in seconds.
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Trace Buffering

Micropak 75XL includes atrace buffer. This records the significant
aspects of the target system after each instruction has been executed.
When execution ceases (such as when a breakpoint has been encountered)
it can be used to show how control reached the current point.

Note that operating with trace buffer active requires Micropak 75XL to
store a significant volume of data after each instruction and consequently
slows execution speed considerably.

Controlling Tracing

Tracing can be activated by selecting ‘ Debug’ from the * Options' menu.
The following dialog box will be displayed:

= Debug Options
HMode: S 2] [ Trace Buffer

Signal Update (s): [1_e-002 ] Enable P
Increment [s): 1.e-00E Size [s):

Script File Commands [~ Signal Buffer

Maximum: [] Enabled
in Time [s): Size [s]:

Click the *Enabler’ check box to activate the trace facility:

Y ou can also specify the depth of the trace buffer in seconds by typing a
valueinto the ‘' Size' field.
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Trace buffer displays

Once a set of execution history information has been captured in the trace
buffer, Micropak 75XL allows you to ‘roll-back’ the displaysin order to
show the information captured. This effectively reverses the direction of
execution through the normal listing display.

For example, in this ‘roll-back’ display, single stepping causes the
previously executed line of code to be the active line rather than the
following line. The activelineis shown in green.

Invoking roll-back displays
The following roll-back displays are available from the * Trace’ menu:
Go back (i.e. back to start of last execution)
Step back into
Step back over
Step out
Step back to cursor
Rolling back is limited by trace buffer size

Because ‘roll-back’ displays operate by interpreting the path through the
code recorded in the trace buffer, the display can not be ‘rolled back’ to
instructions executed earlier than the oldest recorded record in the trace
buffer. Once the beginning of the buffer is reached a message will be
displayed.

In practice the size of the trace buffer is limited and this implies alimit on
how far the trace buffer can be ‘rolled back’.

The depth of the trace buffer is specified on the ‘ Debug Options' dialog
box, accessible from the *Options' menu.

Stepping forward through the buffer

When execution has been rolled back, it is then possible to step forward
again through the buffer until the end of the buffer is reached.
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Any one of the options on the ‘Debug’ menu for controlling execution may
be used for thistask. The PC bar will continue to be shown in green
whilst the buffer is being traversed. Once the end of the buffer has been
reached a message will be displayed and the PC bar will revert to yellow.

Restarting execution

In order to restart real execution the trace buffer display must be at the end
position. If the trace buffer is not at the end position you should issue a
‘Go’ command to step through the buffer to the end and then instigate the
required execution.

Inactive trace buffer

If the trace buffer isinactive, no roll back will be possible. Under these
conditions the menu and toll bar items associated with rolling back
through the trace buffer information will be ‘ greyed out’.
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Breakpoints

Setting breakpoints

Selecting the ‘Breakpoints' option from the ‘ Debug’ menu will cause the
following dialog box to be displayed:

- Breakpoints
Type: Counter: Module:
[ <] [ | [scrrcn ] —=
Variable Constant — |
Type: Location: Length: | Relation: | Walue:
DATA [3] 2 &= ] |
Symbol: Symbol: .
[<None> [2] [PHASEOTE [#] Deos
Identifier: Expression:

| | [two |

Breakpoints:
+ 0/1 Mod PC = STEPPER:5TART
two: STEPPER:COUNT:2 =14
+ 0/1 Mod PC = STEPPER:PHASEODTE & (two)

iaabie

Dodots

III:D
-9
a

Clear All

This dialog box is used to add, remove, enable or disable breakpoints.

Breakpoints in Micropak 75XL are based on the idea of the value of an
item (or ‘variable’) in the simulated system matching, according to a
known relationship (or ‘relation’) a nominated value (or ‘constant’). This
can be thought of as BOOLEAN expression - if the expression evaluates to
true the breakpoint condition has occurred, and if false, it has not.

Thefieldsin the upper part of the dialog box aid the construction of
suitable breakpoint definitions, whilst the lower section of the window
shows alist of currently defined breakpoints in a shorthand form.
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The first example shown in the dialog box is of a breakpoint set on a
single ROM instruction to be met after one occurrence. In more detail the
elements are;

Element Explanation

+ Breakpoint enabled (disabled breakpoints are shown with *-").
This can be controlled directly using a dialog box button. It is
also controlled automatically by Micropak 75XL when
expression breakpoints are in operation.

0/1 Breakpoint will be reached after one occurrence. Thisisinput
by the user in the * Counter’ box.

PC Thisisthe type of the breakpoint. Here ROM locations will be
monitored. The user selects the type from the Type box.

= The location condition specified is shown. For location

Stepper:Start  breakpoints the condition is that the PC reaches a given
location. In this case the PC must equal the location address of
the symbol. The relation can be selected using the Relation
box and a symbolic or absolute address may be specified using
the ‘Value' boxesin the * Constant’ section. Note that for
location breakpoints the only possibility in the *Variable’
section isthe PC. For RAM variable breakpoints symbolic or
absolute RAM addresses may be given. The symbol names are
displayed through selection lists. * Stepper’ is the name of the
module, and only symbols within that module will be shown
in the selection lists. Module names can be chosen from a
selection list available through the ‘Module’ box.

The second example in the dialog box shows a break expression rather
than a breakpoint itself and the third example shows the use of the break
expression within a breakpoint.

Break expressions for either PC conditions or RAM conditions. The break
type PC expression or RAM expression is selected to specify an expression
condition.
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In more detail the elements of the second example are:

Element Explanation

two: Break expression identity. This name will identify the
condition and is entered into the Identifier box

Stepper:Count The RAM condition required. Here we are specifying that the

2=4 RAM location Count which is specified as 2 locations in
length and is defined in the Stepper module should reach the
value 4.

The elements of the third example are as in the first example with the
addition of an expression:

Element Explanation

PC = A PC breakpoint has been specified to examine the expression
Stepper:Phase  ‘two’ when the location PHASEOTE in the STEPPER module
one & (two) is reached. The expression ‘two’ was defined in the second

example. The breakpoint will be triggered if this expression if
found to be true. The expression ‘two’ is specified in the
Expression box

Further details of the possibilities allowed in each box are given in the
following sections.
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Types of breakpoints

This type selection list shows the following possibilities:

RAM Read

RAM Wnte

RAM Read wfrite
RAM Modification
PC Expreszion
RAM Exprezszion

Break at ROM locations

Micropak 75XL alows execution breakpoints to be set on memory
locations as specified in the ‘ Constant’ fields of the dialog box. If the
absolute check box is set then an absolute address must be given,
otherwise a symbolic address may be given. The ‘Relation’ box may be
used to specify a single address or arange of addresses for the condition.

Break on RAM conditions

Micropak 75XL allows break conditions to be set on RAM locations. The
RAM location is specified in the *Variable' fields of the dialog box. The
location may be specified symbolically or as an absolute address. The
length of the RAM areato be monitored may be specified in the length
box. If an absolute address is given the type of the RAM area can aso be
specified using the variable type box:.

BIT

The type of the breakpoint specifies the RAM action to be monitored ie,
RAM reads, writes, modifications. It is also possible to specify a constant
value which must be encountered in order for the break condition to be
satisfied. Thisvalueis entered in the ‘ Constant’ fields. to be monitored by
the breakpoint during the expression then evaluates to a non-zero value
then the breakpoint is considered to have been reached.
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Expression breakpoints

Expression breakpoints allow the user to combine separately specified PC
and RAM break conditions. These conditions are specified using the type
PC expression and RAM expression respectively.

Each break condition is allocated an identity which must be entered into
the identity box. This identity may be used to specify a condition to be
examined when a breakpoint is reached. The breakpoint will then only be
triggered if the expression evaluates to true. The expression box is used to
specify the condition or conditions to be examined.

Simple conditions are specified by simply entering a break condition
identity in the expression box. Break conditions may be combined by
specifying break condition identities and using the following logical
operators to combine them:

& (AND)
‘I (OR)

v (NOT)

The third example given in the diagram here shows a PC breakpoint
which will only betriggered if the expression identified as ‘two’ evaluates
to true. |.e. that the value of the RAM location COUNT is 4.
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= Breakpoints
Type: Counter: Module:
<] [ | [5:ren H —
Variable————————— Constant—————————
Type: Location: Length: | Relation: | ¥alue:
DATA 2] 2 == 2] |
Symbol- Symbaol- -
[<None> 2] [PHASEOTE 2] ool
Identifier: Expression:
| | [two |
Breakpoints:
+ 0/1 Mod PC = STEPPER:START Add
two: STEPPER:COUNT:2 = 4 —
+ 01 Mod PC = STEPPER:PHASEOTE & [two)
Disable
LClear All I

Note that it is not possible to delete individual break conditions until they
have been removed from all expression breskpoints.

The ‘Counter’ field

This edit box is used to specify the number of times that the breakpoint is
to be met before it is considered to have the default valueis*1'.

The ‘Relation’ field

This edit box is used to specify the relationship required between the
‘Variable' field items specified and the * Constant’ field items specified.
The following relations are possible:

The user should select ‘=" if for example he wishes the condition to be met
when the PC meets a particular ROM address and ‘> if he wishes the
condition to be met when the PC is greater than the given ROM address.
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Breakpoint example

The steps necessary to set a breakpoint are summarised by the following
example.

Select the type of breakpoint required from the ‘ Type’ box.

If the breakpoint isa RAM type then define the RAM location using
the ‘Variable' fields.

If the user is specifying locations symbolically it may be necessary to
select the correct module for the symbols using the *‘Modul€e’ box.

Use the ' Constant’ fields to specify the address or value required in
order for the break condition to be met. Also select the correct relation
required.

If the an expression condition is being specified enter a name into the
identity box to identify the condition.

Use the expression box to enter any break condition identities to be
monitored.

Ensure that the * Count’ box is showing the correct number of
occurrences of the condition to be found before the break will occur.

Finally press the Add button on the dialog box to set the condition.

Viewing current breakpoints set ups

The *Breakpoints' dialog box shows alist of current breakpoints and their
status. Thislist is scrollable and one can see all breakpoints set. Clicking
on any one of the breakpoints displayed will transfer al the detailsto the
fieldsin the upper part of the window enabling the detail of the breakpoint
to be easily checked

Setting breakpoints in the listing window

Execution breakpoints on a single address may be set directly when
displaying the source listing window. This may be achieved by moving
the cursor to the required line in the window and clicking the ‘ Toggle
Breakpoint’ icon to set the breakpoint.
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Set a breakpoint by using this icon

The source listing window will show the line on which the breakpoint is
setin red. Note that the F10 key may aso be used for this function.

Removing breakpoints

To remove a breakpoint or break condition, the dialog box should be
activated and the breakpoint to be removed selected from the list. On
selection the details of the breakpoint will be transferred to the individual
boxes so that the user can verify his selection. The ‘Delete’ button in the
dialog box should then be clicked and the breakpoint details will be
removed from the list.

For single location breakpoints which can be seeninred in the listing
window, the *Breakpoint’ icon can be clicked. If the cursor is positioned
on the breakpoint and the button clicked the breakpoint will be removed.

Please note that it will not be possible to delete a break condition if itis
being used in an expression.

Enabling/disabling breakpoints

Individual breakpoints may be temporarily disabled and then re-enabled at
any time using the dialog box. The required breakpoint should be selected
and the ‘Disable/Enable’ button clicked accordingly. The current status of
each breakpoint is denoted by ‘+’ (enabled) or ‘-’ (disabled) in the
breakpoint listing box.

Please note that break conditions used within expressions cannot be
disabled or enabled.
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Script file facilities

Actionsin script files can be controlled and triggered either by event
triggers or by script file breakpoints.

Breakpoints may be set to correspond with breakpoints set within the
simulation. The script language contains a ‘ breakpoint’ function which
allows the user to specify each of the breakpoint conditions described
above.

Further event triggers can be specified during the script language ‘add’
command. Here, triggers can be set to cause an event on:

Test panel input
Port activity
Time-out

When a script file breakpoint or event trigger is reached the action routine
referred to will be triggered and execution of the target code suspended
until the actions have been processed.
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Port Simulation Techniques

Overview

The simulation includes, for each port line, an internal and an external
‘Thevenin’ equivalent network, each of which consists of a single voltage
generator and a single seriesresistance. The internal network is provided
and controlled by the simulation in accordance with the internally set port
controlling conditions such as the state of the port data registers, etc.

For the external network both the voltage and series resistance can be
controlled via the user interface or the script file.

Extending the simulation in this way allows the interaction of the
firmware under test with external hardware elements such as switches,
LEDs, etc., to be investigated, allows checks on the drive capabilities of
the ports and the use of pull-ups, etc.

Pin and port windows

The Micropak 75XL simulation includes all the significant pins of the
target processor. It is possible to invoke a device window for any
additional pin. In addition, it is possible to show summaries of the pin
information grouped as ports. These port views show the logical values at
the port:

F

[ 7 @[] [o][o]
| PH: IEl PO: IEl

.Grouped pin information for a port

Both pin and port views can be updated by overtyping the displayed fields.
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An external voltage/resistance network for every pin

Aninternal voltage/resistance network is simulated for every pin. The
internal ‘ Thevenin’ network is automatically controlled by the simulation
and consists of a single resistance and a single voltage source.

The voltage and the resistance values are specified by the user and can be
changed if desired whilst the target code is running. Furthermore, the
network may also be connected or disconnected from the pin by toggling
the ‘connect’ box in the pin window. :

= P30/ CL * || =

Y-
Latch: IEI

(4 Connect
L N C—
| Ri [ohm):

A network is provided for each pin
Assumed port characteristics

The assumed characteristics of the port hardware are as follows:

Item Assumed value
Pull-up value 40k ohms

Top CMOS 1000 ohms
driver

Bottom CMOS 133 ohms
driver
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Using these networks

Including a simulation of these simple internal and external networks for
each pin alows checks on the behaviour of the internal port hardware.

Consider, as an example, a case in which a particular port line was
intended in a design to be used as a permanent input, sensing the value
being fed to it by a standard CMOS buffer. In this caseit would be
sensible to mimic the external CMOS buffer driver by setting the
resistance value to the output impedance of the buffer (say 100 ohms) and
then specifying the data conditions into the pin by setting the voltage of
the voltage generator to VCC or O (for login ‘1’ or ‘O’ respectively).

Using the simulated network in this way allows the firmware under test to
check the programming of the port. Assuming that the port line was
correctly programmed as an input, the voltage at the port input would
follow closely the rail to rail changes made in the voltage generator
setting. However, if there was a bug in the firmware under test, such that
the internal NM OS buffer on this line was inadvertently activated, the
voltage shown for the pin would deviate significantly from the expected
values, highlighting the drive contention and drawing attention to the bug.

Using script files to control port conditions

Script files can be used to set port conditions using the statements:
connect, setr and setv

Each of these statements are described below:
connect <pin>,<on/off>

This connects or disconnects the external network, depending on the
single parameter given (0 = disconnect, non-zero = connect).
Disconnection is similar in effect to setting the series resistance to an
infinite value.

setr <pin>,<resistance>

The setr statement takes two parameters, the first defining the pin and the
second the series resistance directly in ohms.
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setv <pin>,<volts>

This statement controls the external voltage generator associated with the
pin, using a parameter which defines the desired value directly in volts.

Here is an example sequence of statements which would connect an
external voltage source of 3.6 voltsto pin port 1.1 via a series resistance of
47 k ohms:

setv 43,3.6 : rem 3.6 volts
setr 43,47000 : remviaa47 kR
connect 43,1 : rem connect the external network

Note that the script file facilities provide a flexible mechanism which
allows the parameters of the network to be changed intelligently to
provide, for example, sinusoidal input voltages or switched loads or pull-
ups.

Using script files to check port conditions

The current voltage at any pin is available to script file programs via the
getv expression:

getv(<pin>)

This takes the port pin number as a single parameter and returns the pin
voltage in volts.

Thus, for example, if the pin were to be used to drive a CMOS gate, which
was regarded as having a fixed login threshold of 2.1 volts, the script file
could derive the effective logic value as follows:

let CMOS_VALUE=(getv(43) >= 2.1)

For more details on using script files, see the associated section.

Pin numbering

The pin numbers used in these script statements correspond to the real pin
numbers on the standard package for the simulated device.
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Pull-up control and mask options

Micropak 75XL will look for pull-up controlling mask option statements
when it readsin any listing files. If such statements are detected,
Micropak 75XL will use thisinformation to set the appropriate states of
the simulated port pull-ups.

These are shown in the pin windows and can be changed there if desired.
Note, however, that these values will be re-initialised whenever the
associated mask option statements are read from the listing files and
therefore any manually entered changes will not survive the file reload
that occurs when a project isloaded or re-built. 'Y ou should therefore
ensure that the mask option statements in the source files set the mask
options appropriately.
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Viewing Simulated Objects

Overview

Micropak 75XL provides a number of device windows which allows the
states and activities of simulated objects to be viewed and monitored.
These windows are updated whilst the simulation is running in slow mode
or at the end of execution if running in fast mode. Micropak 75XL also
provides ‘ Test Panel’ facilities to enable users to customise the way in
which they wish to view items.

Displaying RAM
The Data Memory window

The basic memory view facility is composed of an array of valuesheld in a
Data Memory window. It isdisplayed by selecting ‘Device' from the
‘“Window’ menu then choosing ‘Data Memory’ from thelist. The
following window will be displayed

I

= Data Memory
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The window may be sized to include the RAM addresses required. Where
the RAM addresses are not consecutive, this can be accommodated by
opening multiple windows.

Customised memory views.

Test panel windows can be used to show customised views of memory
locations. These panels provide agood ‘application’ view of memory, as
they allow location data to be output in aform specified by the user as
applicable for the task. RAM may be displayed directly or may, for
example, be shown translated into text as decimal numbers to mimic an
application display. Further information about test panelsis given later in
this section.
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Signal recording windows

What is a signal recording window?

Micropak 75XL allows display of pin values and data items as time-based
plots. These are shown in ‘signal recording windows and resemble
oscilloscope traces. Hereis an example:

| = Signals 3
S22 vl =20, el =7, dw =3
W
P23/BUZ: w0 = 9%, w1 =2%, dv="2Y
kd
STEPFER COUMT 1: nd =7 nl =% dn="
600.2 600.|
Time/ms: t0 = 0.000 g, t1 = 0.000 =, dt = 0.000 =, 1/dt = 1.0+l
«| HE
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Viewing Simulated Objects

Setting up a signal window

To set up asignal window you must first select ‘New Signal’ from the
‘Trace’ menu. Anempty signal window will be displayed. Itemsto be
plotted in the window can then be added by selecting ‘ Edit Signals' from

the ‘ Trace’ menu.

The following dialog box is displayed:

[ Other Options
[ y = D line
[4] Shade Signals

+ STEPPER COUNT 1 -3.75-18.7

= Edit Signals
Scale [us/pixel): l:l E E
[ emag
~v-Axi Module:
s [STEPPER 17
b L) Type: Address:  Length:
Upper Bound: 6.25 DATA g?l 1 _§_I
Lower Bound: Symbaol:
|<Nnne) |i|
[ Pin Options -
[ y = (¥dd + GND] / 2 line Signals: | Add |
[ y = ¥dd line + 512 -1.25- 6.25
[ y = GND line + P23/BUZ -1.25-6.25 Sisahis

Druluter

]

Clear All

Type

Signals can be plotted for pins or data memory. The selection can be made

through the type box.

Pin selection

The pins to be included within any one signal window can be selected
from alist of valid pins. Thislist will be activated only if the pin type has

be selected.
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Memory selection

Dataitems or bits may be selected from the memory type box. Symbolic
names may be given for data locations. These may be chosen from a
selection list. A module name selection list allows the user to specify the
module in which relevant symbols are declared. Alternatively an absolute
address may be given. Bit addresses should be given with a period
separating the address and the bit number eg 70.1. If alength is specified
for adata item the value plotted will then be taken from the whole
memory range.

The signal list

Once an item selection has been made, clicking the *Add’ button will
cause the itme to be listed in the ‘' Signals' list. One plot line will be
included within the window for every item shown in the ‘ Signals’ list.

Axes and scales

The scale of both the X and Y axes for the signal plot can be set by the
user. The X axisis scaled in pixels per second and the Y axisin pixels
per volt. Minimum and maximum values can also be specified for the Y
axis, in volts.

Pin Options

Three check boxes are provided so that the user can specify marker lines
they wish to be included in the signal window for pin plots. The following
options are available:

(Vdd + GND)/2 Thisis set at the cross-over point
between logical values 0 and 1.

GND Thisis set at the ground voltage.

Vdd Thisis set at the power supply voltage.
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Other Options

Two check boxes are provided for users to specifiy options they wish to
include on pin and memory signals. These are as follows:-

Oline A marker lineis set at zero volts.

Shade signals Shading between the baseline and the
plot lineisincluded

Removing plot lines

Individua plot lines can be removed from the window by selecting the
signal from the *Signals’ list and then clicking the ' Delete’ button. To
remove all plot lines click the ‘Clear All’ button.

Enabling/disabling plot lines

Individual plot lines can be temporarily disabled and then re-enabled.
Thisis achieved by selecting the plot line from the *Signals’ list then
clicking the ‘Enable’ or ‘Disable’ buttons as appropriate.

The signal buffer must be enabled

The signal window will only be updated with information once the target
code has been executed, so initially the window will be devoid of signal
information. Furthermore, as updating the signal window slows the
execution speed, a check box is provided on the * Debug Options' window
(displayed by selecting ‘Debug’ from the * Options’ menu) allowing you to
enable/disable the signal buffer:
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= Debug Options
Mode: E [ Trace Buffer

Signal Update [s): D Enabled Cancel
Increment [g): 1.e-006 size () 1.¢-003

Script File Commands ™| [ Signal Buffer

Maximum: [ Enabled
in Time [s): Size (=]

Note that this dialog box also allows you to specify the size of the signal
buffer which can hold historical information about the plots and the
frequency of the window updating. Further details on this are givenin the
section on Debug options.

Viewing the results - zooming and snapping

Once the signal information has been generated the window will be
updated with the results. The window is scrollable so that the historical
information held in the signal buffer can be viewed.

You can aso use the ' Signal Zoom In’ option from the * Trace’ menu to
obtain amore detailed ook at any specific part of the signal generated. A
‘Signal Zoom Out’ menu option is also provided if only an overview is
required.

Each time ‘Signal Zoom In’ or *Signal Zoom Out’ are selected the scale of
the display is changed by afactor of two. The maximum and minimum
scales are one million pixels per second and one pixel per second. The
size of the signal buffer is not linked to thisscale. If ascaleisselected in
which part of the display exceeds the size of the buffer, a blank signal will
result.
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If you choose * Snap Signals', the signal window display will show the
nearest point at which the value of the item changed. Note that this may
be a postion either forward or backward in the signal buffer.

On-chip peripherals

All significant on-chip peripherals have associated view boxes. These can
be viewed by selecting ‘Device' from the *Window’ which displays alist
of all valid devices for the chosen processor, e.g.:

Device:

Data Memory

Stack Pointer
Program Status Word
Bank Selection Register
Clock Generator

Port 0

Port 1

Port 2

Port 3

Port 4

Port 5

Port b

Port 7

Clock Dutput

Basic IntervalMwatchdog Timer

kd

Cancel

.Double-clicking aentry in the list displays the selected device

window,e.g.:
= Byl | -
BT: WDTH: IEI
BTHM2-I: BTM3: IEI
1 [fx/4096
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The device window shows, in information fields, al state and numerical
information relevant to the device. The fields within the device window
can be overtyped or changed using selection list options if specific
conditions are required. If necessary, this can be done whilst the
simulation is running.

The types of devices available and the details associated with each are
processor dependent. Therefore, the data sheets for the particular
processor being used should be consulted for the relevant information
about the devices and their constituent parts.

Port views

Port lines may be viewed individually as pins or in summary as a port
window.

A port lineis selected by double-clicking from the list displayed when the
‘Pin’ option is chosen from the *‘Window’ menu. The pin window shows
the effective voltage on the pin and allows the specification of an external
network to be connected to the pin.

To display a complete port, select ‘Device’ from the *Window’ menu then
double-click the required device from thelist, e.g.:

B P30/LCD v |«

v
Latch: IE

[] Connect
it
H Fi [ohm]: H

Port views give the pin values of each individual pin.

The chapter on ‘Port simulation techniques' givers further information.
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Test panel displays

What are test panels?

Test panel displays allow you to draw together a set of items, all related to
aparticular test set-up, to form a display which is particularly convenient
for the tests to be carried out.

The display can be set up to show the states and contents of items such as
port conditions, memory states and script file variables. It provides users
with a convenient ‘front panel’ through which tests can be controlled and
their results monitored. An example is shown below:

= STEPPER.PAN* -

Stepper motor panel

Test panels alow compact views to be built up which keep related objects
together in the display. They alow, for example, the states of the port
lines associated with the keysin a key scanning routine to be displayed in
aformat which can accept key presses.

The resulting input facilities and display can be particularly clear and
convenient when debugging, for example, the key scanning module of an
application.
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Test panel options

Options available from the ‘File’ menu and ‘ Test’ menu allow test panels
to be created and edited.

Menu Panel Option

Test New Panel. Select this option to create a new panel.

File Open. Select this option to open an existing panel.

Test Show Panel Palette. This option is available when a
panel is open and displays the pal ette window.

Test Panel Properties. Select this option to specify or
change the properties associated with an item.

Test Panel Grid Settings. Use this option to change the
grid settings for the panel and turn ‘snap to grid’ on or
off.

Items in each panel can be added to the panel and subsequently moved,
edited or deleted. Each item has a set of properties associated with it (e.g.
a caption to describe the item). These properties can be changed by
selecting the * Panel Properties’ option from the ‘ Test” menu. To aid the
user when aligning itemsin panelsagrid isdisplayed. The ‘Grid
Settings' dialog box, displayed when the ‘ Panel Grid Settings' option is
chosen from the ‘ Test’ menu, can be used to turn the grid on or off.

Micropak 75XL User Manual 111



Test panel displays Viewing Simulated Objects

Setting up a test panel

To set up atest panel select ‘New Panel’ from the ‘Test” menu. An empty
panel window will appear, e.g.:

= - || -

O Flag
O Text
> Edit

The tasks allowed using the palette are described bel ow:
Move

This option allows defined items to be moved in the test panel using the
mouse. Also, if adouble-click is performed when the mouse is positioned
on an item, the * Properties’ dialog box for that item will be displayed.

Flag

The *Flag’ option specifies a test panel flag item which can take one of
two values (‘0" or ‘1"). The condition of the flag will be shown ininverse
video (i.e. active) if it hasthevalue ‘1. The state of the flag is controlled
by eventsin the script file and can, for example, be set to represent the
state of aport line.
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Button

The ‘Button’ option allows button event inputs to be entered by the user.
The buttons are displayed in normal video and the mouse may be used to
click on the button. The displayed button will then be set to show its
‘pushed’ state. When the button is released, an event associated with the
button press will then be generated. This mechanism allows usersto
control eventsin script files. For example, a button event may be used to
trigger a script file event which will set the conditions required for a
simulated real button pressin the hardware.

Text box

This option allows text to be displayed in atest panel. This enablesthe
user to annotate test panels, making testing easier.

Edit box

This option allows text to be entered into the test panel and text output to
be shown in the test panel. This mechanism allows the user to input text
and numbers which may be required to trigger eventsin the script file.
Output generated by events occurring in the firmware may also be shown,
for example, displaying the contents of RAM when a breakpoint is
reached in the firmware. The script file can be set up to monitor the
breakpoint and trigger an event which will display the required locations
when this occurs.

Properties

Each item in atest panel has a number of properties associated with it,
which may be specified or changed using the ‘ Panel Properties’ menu
option or by double-clicking on the item after the ‘Move’ option in the test
panel edit palette has been selected. The properties which can be specified
are given below:
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Property Meaning

Identity The *Identity’ property alows the item to be linked to statements
given in the script file. For example, the script file will use the
‘Identity’ to test panel flag values when actioning events.

Caption The item *Caption’ alows the user to give the item a caption
which is displayed in the test panel.
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Source Debugging

Overview

Source level debugging facilities are provided by Micropak MP75XL. The
source code is shown during execution in the source window and the PC
bar (shown in yellow) tracks the progress of execution through the source.
This source is displayed directly from the source assembler files.

Source held in files input to the structured assembler and macro-processor
pre-processor utilitiesis not shown directly. The structured assembler code
is however shown in the associated source file in comments, and the
macro source is shown in its expanded form.

There are severd facilities provided by Micropak 75XL to aid source
debugging. These facilities are as follows:

QuickWatch. Displays snapshot information about a selected
object or structure.

Watch. Displays constantly updated information about objects.

Stack. Displays the stack contents and provides stack
monitoring

Registers. Displays constantly updated register contents.

With the exception of ‘QuickWatch' any combination of these functions
may be run simultaneously in atest environment. Each of these facilities
is described in this section.

VENTO statement

In order for the source level debbugging facility to work correctly it is
essential that the VENTO directive is given in the source. This directiveis
used by the listing converter in the 75X tool chain when generating the
debugging information required. The directive MUST be preceded by
eight spaces and NOT A TAB in the source file. Furthermore it MUST
be entered in uppercase.
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NAME pseudo mnemonic

The MP75XL assembler allows you to use a NAME pseudo mnemonic to
specify the name of the source file. If you use this facility please ensure
that the name you give matches the actual name of the source file but
without the extension. Thiswill enable MP75XL to locate the symbolic
information correctly. Note: A warning is given during redbuild if amis-
match is found.

Source Windows

MP75XL alows you to open one or more views of the source code you are
debugging. This allows you to watch the progress of execution through
different parts of you code and & so allows you to edit the code held in
different modules directly.

Whenever codeis exeucting in ‘Slow Mode' the yellow PC bar will track
the execution of code in a source window. The PC bar will move between
any open source windows. If a new window is required to show the PC
bar, MP75XL will automatically open it and display it on top of the
previously activated source window.

The current window focus may be set by the user either into a source
window or into any of the non-source windows. If the focusis setin a
source window, MP75XL will automatically change the current window
focus between open source windows so that the focus or active source
window is changed when the PC changes. If the focusis not set in a source
window, the focus will not be changed. MP75XL will however place the
source window currently showing the PC on the top of any ‘Z’ ordered
source windows open, so that the user may view the currently executing
source.

Y ou may edit any of the source windows, however please note that
changes to the source code will not become effective until a project rebuild
is made.
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QuickWatch

The purpose of the ‘QuickWatch' facility isto enable you to quickly
inspect avariable or type. Thisis achieved by moving the cursor into the
variable name to be interrogated then selecting ‘ QuickWatch’' from the
‘Debug’ menu or clicking the * QuickWatch’ tool bar icon: :

When selected, awindow displaying information about the selected item is
displayed:

= QuickWatch
Symbol:
Length: *
|COUNT | P [
Value Baze Cancel

_ O Binary
S |t Aad o o
Now [ | ®becim

O Hexadecimal

All data symbols loaded into Micropak 75XL have alength of 1 regardless
of the length declared in the source file. Thusif you wish to view a symbol
of length greater than 1, you must change the length box.

The current value of the variable is shown and this may be changed by
entering anew vaue in the ‘New’ box. The base of the variable may be
selected .

If you wish to subsequently monitor an item on an ongoing basis, the *Add
to Watch’ button may be clicked to transfer the item to the ‘Watch’
window and simultaneously close the ‘ QuickWatch' window.

Note that the variable being inspected must be in scope.

Micropak 75XL User Manual 117



Watch Source Debugging

Watch

This facility allows the ongoing viewing of items while they are being
constantly updated by the executing program. It is selected by either
choosing ‘Watch’ from the “Window’ menu or by clicking the ‘ Add to
Watch' button from the * QuickWatch’ menu.

In either case awindow similar to the following is displayed:

[ VAL COUNT = 1
VAL:C1.2 = 00000k

4.|| I*.

Any itemstransferred from the * QuickWatch' facility will be displayed at
the top of this window. Note that the full dataitem nameis given, ie the
module name followed by the variable name. The length of theitemis also
given. Thisis shown separated from the name by a point.

Adding items to the ‘Watch’ window

Further items can be added to the ‘“Watch’ window in one of three ways:
By transferring other items from * QuickWatch’ windows.
By typing the name of the item to be monitored.
By using the Add to Watch menu option

The second method is accomplished by clicking the edit cursor into the
next empty line on the *Watch’ window (i.e. either the first line of the
display area or the blank line below the last item already displayed) and
typing in the variable name required followed by the ‘Enter’ key. The text
ischecked and if it isavalid item, the value is displayed and updated
accordingly. If theitem isinvalid the text ‘ <undefined>' will be displayed
adjacent to it.
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The module name and variable name entered should be separated by a
colon. If no module name is given, then the module name of the code
currently being executed, ie ‘in-scope’, will be assumed. If the variableis
not defined in the *in-scope’ module, the symbols will be searched for a
matching variable irrespective of the module name.

If no length is given then a default length of 1 is assumed. The length of
the data item to be viewed should be entered in decimal separated from the
name by afull point character.

The third method of entering data into the ‘Watch Window’ is
accomplished by invoking the ‘ Add to Watch' option from the * Debug’
menu. The following dialog box is displayed:

= Add Watch ltem

Module:

it E Length:

Symbol: Baze Cancel

|E1 |£I ) Binary

i Octal

w Decimal

O Hexadecimal

Here items can be selected by choosing module names and symbol names
from selection lists. The length of the item can also be specified as can the
base to be used for the display of the contents.

Stack contents

The stack pointer window may be selected from the list of devices shown
from the Device option of the Window menu. This window displays not
only the current value of the stack pointer but also the current stack
contents.

Micropak 75XL User Manual 119



Watch Source Debugging

When selected a window similar to the following is displayed:

= [ * || =

SP- Contents:

_ 007E 10000000 B0
SBS3:  [1] |oo7c 10000001 81
58510 [0 007A 10000010 82

go7g 10000011 83
0076 10000100 B84
STACKTOP: 0074 10000101 85

0080 0072 10000110 86
PRI 0070 100007111 87
{ 0020

The symbols STACKTOP and STACKSIZE must be declared in the
program source for this window to function correctly. The symbol
STACKTORP should be set with the initial value loaded into the stack
pointer and STACKSIZE should be set to the size of the memory areato
be allocated to the stack. The stack contents will always display the last
value entered on the stack as the bottom line in the window.

Micropak 75XL checks the bounds of the stack throughout the program
execution and an error box will be displayed if the stack underflows or
overflows the bounds set.

Y ou are able to change the contents of the stack by selecting the address to
be changed and double-clicking the mouse on the selected item. A dialog
box similar to the following will be displayed:

= Modify Stack
Address: 0078

¥alue: |EE | Cancel I
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Registers

The contents of the registers can be monitored by selecting ‘ Registers
from the *Window’ menu. A window similar to the following is

displayed:

ot=]
hl
d=
b

=a
hl'
de='
b

P= =

Hegisters
g8 ovw =10
nn =k =10
oo i=t =0
00 mhe = 0
rhe = 1
nn
00 mh= = 0
00 b= =0
00 =sh= = 8
000z =p = 70

3

[ [

«| |

The register values may be changed by overtyping the displayed register
contents. Please note that the register names themselves are shown in

green indicating that these items may not be changed.
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Using Script Files

Overview

Micropak 75XL can process sets of commands contained in script files.
These commands can set or check conditions in the simulated system and
can be used to run tests automatically or to mimic the behaviour of
external hardware.

The command format resembles a simple high level language such as
BASIC. The functions which are provided are chosen to simplify the
selection of predefined tests or the simulation of external events or items.

Test panels may be used both to display the results of the script processing
events and pass input, via user action, to the script processing function.

Script files - Purpose and uses

Script files alow users to extend and customise the simulation facilities
and in particular to:

Extend the simulation by providing automatic handling of
external events. The script file facilities allow the behaviour of
external hardware and other devices to be simulated
automatically.

Set up semi-automatic control of testing sessions. This allows
the running of repetitive or regression tests semi-automatically,
by setting up RAM data, running code sessions and checking
results.

Test panels and their relation to script files

Test panels are used to provide a user defined, and application specific,
user interface to the program under test via script files facilities. They
alow, for example, port lines to be controlled by ssimple ‘point and shoot’
actions whilst the target code is running.
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Examples of script file and test panel uses

The flexibility and power of the script panel and test panel combinations
allow them to be used in many differing ways, for example:

Simulating the relationship between triac devices and a delayed
thermistor reading in a heater control application, using test
panels to display the drive, critical temperatures and effective
power applied. Script files could be used to model the changes
in performance and relations between the peripheral elements
associated with a range of mains voltages or thermal
characteristics. They could also show the average main voltage
at switching points - allowing the accuracy of zero-cross
switching algorithms to be assessed.

Simulating a DC motor. The script file could be used to relate
acceleration to drive signals and relate speed to back-emf, etc.,
building up to an accurate model of a physical motor.

Simulating custom LCDs with simple test pattern flags.

Modelling membrane keypads or other switch inputs, including
switch bounce and other non-ideal characteristics.

Generating serial bit streams such as asynchronous data at
differing baud rates to test firmware implemented UART
decoding.

Simulating the performance of firmware implemented ADCs by
modelling the functions of external comparators/ RC networks,
€tc.

Checking zero cross timing handling by generating a range of
waveforms or mixtures of waveforms on the associated pins, etc.

Modelling the known characteristics of real sensors (such as
pulse generating flow sensors). Test panels would allow the
user to set and display flow rates, whilst the script files could
convert thisto apulse train at an appropriate frequency.

Simulating inertia of stepper motors, therefore detecting
conditions where the firmware ramps the drive speed too
quickly.
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It can be seen that the applicability of the test panel and script file
combination is very wide ranging. It is particularly advantageous in that
extensive testing can be performed in the ssmulated environment before
any hardware is ready, or when the consequence of generating incorrect
control signalsin the real environment would be undesirable. The
environment is also very suitable for theoretical and repeatable testing,
allowing, for example, one control agorithm to be tested against another
in standard conditions.

Module testing is an activity for which the smulated environment is ideal,
allowing data tests to be set up easily, and run semi-automatically under
the control of an appropriate test panel.

The script language

The grammar and syntax

Hereisasummary of the main features of the script file grammar and
syntax. For afull, formal definition in modified Backus-Naur form, see
the script file syntax shown as an Appendix.

Here isan informed, narrative description of the grammar and syntax:
Statements and lines
Script files are made up of statements.

Statements must end with a terminator which can be either a
normal end of line (i.e. line feed or carriage return/line feed
pair), or acolon character, ‘3’

Null statements (such as blank lines) are allowed

Most statements follow a simple logical format, which is very
similar to BASIC

Hereis an example of a single line statement:

let SignalVolts = sin (TimeBase)
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Here is another example showing two statements on asingle line,
separated by the '’ character:

letA=B+C : letD=D*E
Elements of script file statements

Script statements are composed from a number of different elements.
These are asfollows:

Keywords Identify statement types (such as ‘if’, ‘poke’, ‘goto’,
etc.), built-in functions (such as ‘sin’, ‘cos’, ‘atan’,
etc.) and qualifiers (such as ‘button’, ‘pin’, ‘edit’).

Variables Identify user data variables. Examplesinclude
‘MyVar', ‘SignalVolts, ‘timebase’ and
‘StartButtonld$'. Variables can be integers, real or
strings.

Operators These alow variables and functions to be combined
where necessary to form expressions, such as ‘ Scale *
cos (timebase)’, where the **’ is the multiplication
operator.

These elements are described in more detail in the sections which follow.

Note on comment delimiters

The ‘rem’ statement allows the insertion of comments. Becauseit is
statement it must be preceded by a terminator to separate it from any other
preceding statements on the same line.

The apostrophe character, ’, can be used anywhere on aline to introduce a
comment and does not need a preceding terminator.

In both cases the comment is considered to last until the next end of line
and comments can therefore include ‘:’ characters.
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Script file variables

Internal script file variables are required in order to control and action
events. Thetable below lists the type of variables available:

Type Description

Integer Holds integer values. The variable nameis suffixed
with the ‘%’ character (e.g. ‘count%’).

Real Holds floating point values (e.g. ‘value').

String Holds string values. The variable name is suffixed
with the‘$’ character (e.g. ‘name$').
Variable identifiers
The following set of rulesis applied to variables:
Variables are named by the user
They need not be declared before use
Thereis no significant limit on the length of variable identifiers

They cannot be reserved words.

Examples of variables

Name Notes

Signal Voltage A redl (i.e. floating point) because it hasno ‘%’ or '$
suffix.

ButtonName$ A gtring (hasa‘'$’ suffix).

SignalVolts% An integer (i.e. a 32 bit signed number) because it has
a‘'% suffix.
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Numeric type conversions

Like BASIC, the script facilities provide automatic type conversion, as and
when appropriate, between Real and Integer values. These types can be
mixed in numeric expressions and built-in functions, such as
“abs(<numeric expression>)’ or ‘ cos(<numeric expression>)’, can be
called with either type or a mixed numeric expression as a parameter.

Script operators and expressions

Hereisan informal list of the various operators supported by the script file
processor when evaluating expressions. A formal definition of the full
syntax of the script language isin the Appendix.

Item Purpose

* Multiplication operator

/ Division operator

> Relational greater than operator

>= Relational greater than or equal to operator
< Relational less than operator

<= Relational less than or equal to operator

= Relational equal operator

<> Relational not equal operator

+ Addition operator

- Arithmetic negation operator and subtraction operator

N Exponentiation operator (raise to the power)
and Logica and operator

eqv Logical equivalence operator

imp Logica implementation operator

not Logica complement operator

or Logical inclusive or operator

Xor Logica exclusive or operator
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Script operators and expressions

Script operator precedence and associativity

Operator Description Precedence Associativity
n raise to power 0 left
- unary minus 1 right
* multiplication 2 left
/ division 2 left
+ addition 3 left
- subtraction 3 left
> greater than 4 left
>= greater than or equal 4 left
< less than 4 left
<= less than or equal 4 left
= equal 4 left
<> not equal 4 left
not logical not 5 right
and logical and 6 left
or logical or 7 left
Xor logical exclusive or 8 left
imp logical implication 9 left
eqv logical equivaence 10 left
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Example expressions
let A=B + C*D + Param ™ Power : rem real numbers
let A$ = NICK$ + NAMES$ : rem string concatenation

Note - String Expressions. For string variables, ‘+' (concatenation) is the
only supported operator.

Script file execution and control flow

Files built from statements
Script files are divided into executable statements.
Events start script execution from labelled entry points

Within a script file [abels show entry points at which the script file actions
can commence. In operation, the execution of the commands in the script
fileistriggered by ‘events. These events can be user key strokes, script
file breakpoints, or the passage of simulated real-time in the target system.
When a nominated event occurs, execution of the script file commandsis
started at the labelled entry point associated with that event.

Control flow

Execution normally follows sequentially from the first statement to the
next statement in the file, however, control transfers using ‘ goto label’ and
‘gosub label’ statements are possible.

Execution always begins at a labelled entry point and continues until an
‘end’ statement isreached. If the Micropak 75XL simulation was
executing code when the originating event occurs, it is suspended whilst
any script file segment is still running.

When all segments have run to completion, the simulator execution is
resumed.
More on script file events

Script files can be driven by events. An event trigger must first be set up
to drive an event. There are five different types of trigger, these being
‘breakpoint’, ‘button’, ‘edit’, ‘pin’ and ‘timeout’. Each event, and how to
set up itstrigger, is described in the subsequent pages.
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All event handlers have a similar format. A simple code skeleton would
look something like this:

event:
commands...
end

The label ‘event’ isthe label associated with the event trigger. The ‘end’
command goes at the end of any other commands in the event handler.
Thisindicates that the event has finished.

Breakpoints

These events occur when breakpoint conditions, similar to the ones that
can be defined in the ‘ Breakpoints' dialog box, are met. These
breakpoints are not, however, displayed in the dialog box nor do they stop
execution of the simulator. Instead, they cause a section of the script file
to berun. The simulator can be stopped from here, if necessary, by
executing a‘stop’ command.

Breakpoint event example

The following piece of code sets up alocation breakpoint event trigger at
an address “interrupt” in the module “main.asm”. The location
breakpoint is hit whenever the PC reaches this location (indicated by the
value ‘1’ for the count argument). The script file code at label “event” is
run when this occurs. The integer variable ‘bp1%' holdsthe ID for the
breakpoint. This can be used to set enable and dissable the event trigger
and to specify the code to be run when the event occurs.

let bp1% = breakpoint (“PC”,1,“main”, “”,0,“=",
“interrupt™)

The following code will action the breakpoint event trigger ‘bpl%':
on event (bp1%) run breaklabel

For more information refer to the descriptions for the ‘on event’ and
‘event’ commands and the * breakpoint () function.

Button events
These occur when buttons are pressed and released in test panels.
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Button event example

The following piece of code sets up a button event trigger within atest
panel with ID “start”. Note that atest panel containing such a button need
not exist when the script fileisrun. Thisis because the links between the
script file and the button are made at run-time.

let start% = button( “start”)

Identifies the button “ start” with the variable start%.
event (start%) on
on event (start%) run startlabel

Edit events

These occur when edit boxes in test panels are modified and then lose
their input focus. Note that if a script file updates an edit box through an
edit command then any modifications will be lost.

Edit event example

The following piece of code sets up an edit box event trigger on an edit
box within atest panel with ID “duration”. Note that a test panel
containing such a button need not exist when the script fileisrun. Thisis
because the links between the script file and the button are made at run-
time.

let a$ = edits(“name”)

Returns a string holding the contents of the test panel edit box with
identity “name”.

event (a%) on

on event (a%) run durationlabel

Pin events

These occur when there is a voltage change at a pin.
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Pin event example

The following piece of code sets up a pin event trigger on apinin the

processor. ‘SCK%' is an integer variable defining the pin number of the

serial clock (SCK) pin.
let a% = pin(SCK%)
event (a%) on
on event (a%) run event
Timeout events and timeout event example

The following piece of code sets up atimeout event trigger. The event
will occur after “TIME” seconds has elapsed in simulated time. In the
example given, “TIME” isreal variable:

let time% = timeout(0.5)
event (time%) on

on event (time%) run timelabel
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Identities in script files

There are numerous script commands and functions that make references
to objectsin test panels: the commands and functions include * button’,
‘edit’, ', ‘getedit’, ‘setedit’ and setflag.

Objectsin test panels are referenced through identities. These are strings

which identify and name test panel objects. In the commands and
functions these are given as simple string expressions.

Links to test panel objects are made at run time. Therefore, when a script
fileis executed it is only necessary for the test panel object to exist if a
command to which it is referenced is encountered. If by mistake an object
does not exist then an error message is displayed.

An object in atest panel which can be referenced from a script file has an
identity (1D) associated with it. When an object is created in atest panel it
is given adefault identity. This can be re-defined by displaying the
properties dialog box for that object, and modifying the test in the ID edit
box. It isrecommended that IDs are customised for each object.

Example
let start% = button( “start”)

Identifies the button “ start” with the variable start%.
event (start%) on
on event (start%) run startlabel

These commands add a button event trigger and turn it on. When the test
panel button with identity “start” is pressed (and then released) it will
cause the script code at label “startlabel” to be executed.

event (start%) kill

Deletes the button event trigger from the button in the test panel with
identity “start”. Thisis effect kills off the event trigger which was added
in the first example.
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setedit “duration”, 4

Sets the contents of the test panel edit box with identity “duration” to *4’.
Note that the second argument to the edit command can be an expression
of type integer, real or string.

setflag “pulse”, 1

Sets the test panel flag with identity “pulse” to the highlighted state. The
second argument to the flag command is a numeric expression. The flag
is highlighted when the expression evaluates to any value other than zero.

let a% = edit (“duration”)

Returns the numeric value of the test panel edit box with identity
“duration”. The function returns areal argument. In the example above it
istype converted to an integer.

let a% = edits(“name”)

Returns the numeric value of the test panel edit box with identity
" narr]e” i

event (a%) on
on event (a%) run durationlabel

Adds an edit box trigger. When the test panel edit box with identity
“duration” is modified and the input focus lost, the code at 1abel
“durationlabel” will be executed. Note that if a script file updates the edit
box through the edit command then any modifications will be lost.

event (a%) off

turns off the edit box event trigger but does not remove it from the edit
box.
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Script keywords

These keywords define script statements, qualifiers and built-in script
functions. There are described more fully in the following sections.

For aformal definition of the full syntax of the script language, see the
script file formal syntax description given as an Appendix.

Item Purpose

abs Built-in script function - returns the absolute value of a numeric
expression.

acos Built-in script function - returns the arc cosine of a numeric
expression.

asin Built-in script function - returns the arc sine of a numeric
expression.

atan Built-in script function - returns the arc tangent of a numeric
expression.

breakpoint  Built-in script function - to specify breakpoints on which script file
event will be triggered.

button Statement qualifier, used with ‘add’ and ‘delete’.

close Close afile stream

connect Script statement - connects/disconnects Thevenin network to pin.

cos Built-in script function - returns the cosine of a numeric expression.

delete Script statement - allows script file event triggers to be deleted.

edit Built in script function - Creates a breakpoint event and returns the
number of the event

else Used with *if’.

elseif Used with ‘if".

end Script statement - specifies the end of an event.

endif Used with ‘if".

event Script statement - provides control for breakpoint trigger events

event on turns on a breakpoint trigger events

event off turns off a breakpoint trigger event

event kill delete a breakpoint trigger event

exit exit from the scrip file

exp Built-in script function - returns the value of an exponential function
with ‘€ asits base.

for Script statement - specifies the start of afor loop in the script file.
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Iltem

getedit

getedit$
getfx
getfxt
getpc
gettime
getv

go
gosub

goto

if

input
let
next
on event
run
open
peek
poke
pin
print
rem
repeat
return
setedit
setflag
setpc
setr

setv

sin
sgn

Purpose

Built-in scrip function - allows data to be returned from, a test panel
edit box. returns avalue from atest panel edit box.

Built-in script function - returns strings from a test panel edit box.
Built-in script function - returns (gets) the voltage value at a pin.
Built-in script function - returns (gets) the voltage value at a pin.
Built-in script function - returns (gets) the voltage value at a pin.
Built-in script function - returns (gets) the voltage value at a pin.
Built-in script function - returns (gets) the voltage value at a pin.
Script statement - starts the execution of the target code.

Script statement - performs an event in the script file as a subroutine
and returns here on encountering a return statement or an end
statement.

Script statement - transfers script control to the label specified as
the destination.

Script statement - conditional statement allows the behaviour of the
script file to be adapted automatically to actions and states that
occur in the target system.

Script statement for inputting data from afile

Script statement - assignment.

Used with ‘for’.

Script statement - conditional statement to allow parts of script files
to be run conditionally

Script statement for opening afile

Built-in script function - returns a value from target memory.

Script statement - puts a value to target memory.

Statement qualifier, used with ‘add’ and ‘delete’.

Script statement for writing datato afile

Script statement - introduces a comment.

Script statement - used with ‘until’ for control |oops.

Script statement - specifies the end of a script file subroutine.

Script statement - allows data to be output to atest panel edit box.
Script statement - allows data to be output to atest panel flag box.
Script statement - sets the target PC to agiven value.

Script statement - sets the resistance value for the external Thevenin
network of apin.

Script statement - sets the voltage generator value for the external
Thevenin network of a pin.

Built-in script function - returns the sine of a numeric expression.
Built-in script function - returns the sign of a numeric expression.
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Iltem
sqr
step
stop
tan
then
timeout

until

Purpose

Built-in script function - returns the square root of a numeric
expression.

Used with ‘for’ statement to define the loop increment.

Script statement - stops the execution of the target code.

Built-in script function - returns the tangent of a numeric
expression.

Used in ‘if’ statements.

Script statement - specifies a timeout which will be monitored to
trigger events when the timeout expires. This facility allows testing
of time dependent routines in the target code.

Used with ‘repeat’

Note that some script operators are a so reserved words (e.g. and, xor, €tc).
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Script file commands and functions

This section describes the various script file commands and functionsin
detail. They are given in aphabetical order.

ABS

Script file function. Returns the absolute value of a numeric expression.
Format

abs (<value>)

value input parameter (numeric expression)

Example

let a = abs(-1.6) ‘would return 1.6

ACOS

Script file function. Returns the arc cosine (in radians) of a numeric
expression.

Format

acos (<vaue>)

value input parameter (numeric expression)
Example

let a = acos(1) ‘would return 0
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AND

Logical and operator. The and operator performs a bitwise operation on
two integer operands.

The truth table for the operator is:

X Y XandY
1 1 1

1 0 0

0 1 0

0 0 0
Example

let a% = b% and c%

ASIN

Script file function. Returns the arc sine (in radians) of a numeric
expression.

Format

asin (<value>)

value input parameter (numeric expression)
Example

let a = asin(1) ‘would return pi/2
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ATAN

Script file function. Returns the arc tangent (in radians) of a numeric
expression.

Format

atan (<value>)

value input parameter (numeric expression)
Example

let a = atan(1) ‘would return pi/4

BREAKPOINT

Thisis a function which allows the details of breakpoints to be set in script
files.

Breakpoints set in this way act as event triggers. The specification of
breakpoints in this function allow a similar range of options to those

provided by the user breakpoint facility in the smulator (which is accessed
viathe ‘Breakpoints' dialog box).

When the breakpoint is reached the event handler defined within the call
to the breakpoint function will be triggered.

The value returned by the function is an number which identifies the
breakpoint for subsequent deletions, and should be stored and used for this
purpose. If the breakpoint could not be set avalue of -1 will be returned.

Formatl

breakpoint (<type>,<counter>,<module>,<variable-
type>,<location>,<variable-length>,<rel ation>,<break value>)
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Format2

breakpoint (<type>,<counter>,<module>,<variable-symbol>,<variable-
length>,<relation>,<break value>)

Parameter Meaning

type breakpoint-type

“PC” Memory location type

“RAMR” RAM location read

“RAMW” RAM location write

“RAMRW” RAM location read/write

“RAMMOD” RAM location modified.

Counter an integer expression or value specifying the number of
times the break condition should be reached before an
event istriggered.

Module the name of the module in which the location of the

Variable type
(format 1 only)

«BIT”
“DATA”

location
(format 1 only)

variable symbol
(format 2 only)

variable length

breakpoint control variable is located.

the type of the breakpoint location to be evaluated. Two
sets of values are possible depending on the breakpoint
type. These are described below:

for ‘RAM’ types only
for ‘RAM’ types only
the address of the breakpoint location

the symbolic name of the breakpoint location

the length of the variable in nibbles - values 1to 8
(ignored for PC breakpoints)
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BREAKPOINT

Parameter Meaning

relation the relation to be used in evaluating the breakpoint
condition. The following values can be used:

“<” breakpoint location less than value

fe= breakpoint location less/equal to value

> breakpoint location grester than value

>z breakpoint location greater than/equal to value

o=t breakpoint location equal than value

> breakpoint location not equal than value

break value the value against which the breakpoint location isto be
checked.

Examples

Thisfirst example sets a script file breakpoint to invoke the script event
handler. The condition to trigger the event will be alocation (PC)
condition occurring (1) times, when the PC (=) the label
(END_OF_TEST) in the module (*“coreb.asm™). Note that the location
field hereisadummy - given as (0). The breakpoint identifying number
is stored in bp1% for use later when the breakpoint needs to be triggered,
set on, off or deleted (see the EVENT statement).

let bp1% = breakpoint
("PC",l,"COI’eb","",O,":“,"END_OF_TEST")

This second example sets a script file breakpoint to invoke the script event
handler at the label (portbrk). The condition to trigger the event isa RAM
write condition (RAMW) which needs to occur (1) times when the RAM
variable address at the symbol (MY VAR) defined in the module
(stepper.asm) is written to any value greater than or equal to (=) O.

let bp2% = breakpoint ("RAMW?”,1,”stepper”,”"MYVAR”,”=*,0)

Again, the breakpoint identifying number is stored, this time in bp2%, for
use later when the event needs to be triggered.
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CLOSE

Close afile.
Format
close <file number>

file number avalid file number (numeric expression) as obtained from
the open statement.

Example

close #1

CONNECT

Connects/disconnects Thevenin network to a pin.

Format

connect <pin number>, <connect,disconnect>

pin number avalid pin number (numeric expression)

connect/disconnect  value 1 or O to show connected or disconnected (numeric
expression)

Example

connect startpin%,1
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COS

Script file function. Returns the cosine of a numeric expression (in
radians).

Format

cos (<value>)

value input parameter (numeric expression)
Example

let a = cos(2 * 3.1415926/6) would return (approximately) 0.5

EDIT

Specifies that a breakpoint trigger event is to be set on atest panel edit
box. Thisisafunction which returns an event trigger number.

Format
edit <"identity” >
identity name of atest panel edit box

data data to be output. Data may be integer or string values (numeric
expression) or (string expression)

Example
let flagvar% = edit(“DISP”)

on event (flagvar%) run toggle
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END

Specifies the end of an event. Control will flow through eventsin the
script file until this command is reached.

Example

end

EQV

Logical equivalence operator. This operator performs a bitwise operation
on two integer operands. The truth table for the operator is:

X Y XeqvVY
1 1 1
1 0 0
0 1 0
0 0 1
Example
let a% = b% eqv c%
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EVENT

Allows event triggers to be turned on or off or deleted.

Event trigger actions are specified by setting the value from an event
function to a script file variable. The script file variable is then used to
specify the event. The possible event functions are Breakpoint, Button,
Edit, Pin and Timout. Y ou should refer to the relevant section of this
manual for details of the functions.

The action routine to be run when the event occursis specified by the ON
EVENT statement.

Both the button and edit formats below refer to objectsin test panels. A
button event is triggered when a test panel button is pressed and then
released. An edit event istriggered when an edit box in atest panel is
modified, and the edit box then loses the input focus. Note that if a script
file updates the edit box then any modifications will belost. The pin
format refers to the pin on the processor. A pin event istriggered
whenever there is avoltage change at the pin in question.

Format
event (<identity>) <status>
identity the identity of the event a script file variable
status on - turn the event on
off - turn the event off
kill - remove the event
Examples
let timer% = timeout(0.5)
on event (timer%) run toggle
event (timer%) on
let press% = button (“start”)
on event (press%) run toggle

event (press%) on
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EXP

Script file function. Returns the value of an exponential function with ‘€
asits base.

Format

exp (<vaue>)

value input parameter (numeric expression)
Example

let a = exp(2) ‘would return ‘e’ raised to the power 2

FOR - TO - [STEP]

Specifies the start of afor loop in the script file. This allows commandsin
ascript file to be repeated a specified number of times.

Format

for <control> = <start> to <end> [step <increment>]

control an internal variable which will be incremented each time around the
loop

start the starting value to be set (numeric expression)

end an ending value against which the contents of the control variable

will be checked. When the control variable value matches the end
value, the for loop will be terminated (numeric expression)

increment  an optional step increment to be added to the control variable
(numeric expression)

Example
for count% =0 to 10

for count% = start% to end% step 2
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GETEDIT($)

Script file function. Allows data and strings to be returned from atest
panel edit box.

Format

getedit (<identity>)

getedit$ (<identity>)

identity input parameter (string expression)
Example

let a$ = edits(“string”)

GETFX
Read the frequency of the main system clock.

This statement may not be used on its own but must be used as an
expression within other statements.

Format
getfx()
Example

let clock = getfx()
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GETFXT

Read the frequency of the sub-system clock. This statement may not be
used on its own but must be used as an expression within other statements.

Format
getfxt()
Example

let subclock = getfxt()

GETPC

Read the current value of the program counter. This statement may not be
used on its own but must be used as an expression within other statements.

Format
getpc()
Example
let pc = getpc()

GETTIME

Obtain the currently held simulation time. Thistimeis expressed in
seconds.

This statement may not be used on its own but must be used as an
expression within other statements.

Format
gettime()
Example

let simtime = gettime()

150 Micropak 75XL User Manual



Using Script Files
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GETV
Read the voltage on apin. The voltage read is expressed in volts.

This statement may not be used on its own but must be used as an
expression within other statements.

Format
getv(<pin number>)
pin number avalid pin number (numeric expression)
Example
setv startpin%, getv(Gnd%)
let VOLTS = getv(9)

GO

Starts the execution of the target code. There are no parameters.
Example
go

GOSuUB

Perform an event in the script file as a subroutine and return here on

encountering areturn statement or an end statement.
Format

gosub <label>

label the label of the event to be performed
Example

gosub show
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GOTO
Transfers control to the label specified.

Format

goto <label>

label the label of the destination
Example

goto show

IF - THEN - [ELSEIF] - [ELSE] - ENDIF

A conditional statement which assesses the value of an expression and
performs a set of statementsif the condition is found to be true.

Optionaly, a different block of statements may be performed if the
expression is not found to be true. Statement blocks are terminated by the
EL SEIF, EL SE or the ENDIF, whichever is appropriate.

Format

if <expression> then <statement block> [elseif <statement block>] [else
<statement block>] endif

expression  which can be evaluated to true or false (numeric expression)

statement one or more statementsin ablock. The block is terminated by
block either ELSEIF, ELSE or ENDIF

Example
if getv(driv1l%) < threshold then
setflag “MOTOR1”,0
elseif
setflag “MOTOR1”,1
endif
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IMP

Logical implication operator which performs a bitwise operation on two
integer operands. The truth table is as follows:

X Y XeqvVY
1 1 1

1 0 0

0 1 1

0 0 1
Example

let a% = b% imp c%

INPUT

Obtains a value from afile.
Format

input #<file> <item>

file number of the file as given on open
item name of a script file variable (string expression)
Example

input #1,drivi%

Micropak 75XL User Manual 153



LET Using Script Files

LET
Assigns avalueto an internal script file variable.

Format

let <item> = <value>

item name of a script file variable (string expression)
value input parameter (numeric expression)
Example

let drivl% =9

NOT

Logical not operator which performs a bitwise operation on an integer
operand.

The truth table for this operator is as follows:

X not X
1 0

0 1
Example

let a% = not a%
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OPEN

Open afile for capturing data or inputting data.

Format

open <filename>,<FOR mode> <access> <lock> A S #<expression>

filename

mode

access

lock

expression

Example

name of the file to be opened
FOR mode type which is one of :-
APPEND
INPUT
OUTPUT
READ WRITE
WRITE
SHARED
LOCK READ WRITE
LOCK WRITE

numerical expression between 1 and 255 to identify the file

open “serdata.txt” for input access read as #1

open “testl.txt” for append access write as #2
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OR

Logical or operator which performs a bitwise operation on two integer
operands. The truth table is as follows:

X Y XeqvVY
1 1 1
1 0 1
0 1 1
0 0 0
Example
let a% = b% or c%
PEEK
Function which gets a value from target memory.
Format
peek (<memory>)
memory address of memory location (numeric expression)
Example

let count% = peek(“COUNT”)
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PRINT

Obtains a value from afile.
Format

print #<file> <item>

file number of the file as given on open
item name of a script file variable (string expression)
Example

print #1,driv1%

POKE

Writes a value to target memory.
Format

poke <memory>,<value>

memory address of memory location (numeric expression)
value value to be output (humeric expression)
Example

poke “COUNT”,4
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REM

Comment statement in a script file. This statement can be followed by any
textual information. It may be used on an individua line or on lines
containing a statement:

Example

rem Highlight the flags showing the phases of the stepper

Note on comment delimiters

The rem statement allows the insertion of comments. Becauseitisa
statement, it must be preceded by a terminator to separate it from any
other preceding statements on the same line.

The apostrophe character * can be used anywhere on aline to introduce a
comment and does not need a preceding terminator.

In both cases the comment is considered to last until the next end of line,
and comments can thereforeinclude ‘:’ characters
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REPEAT - UNTIL

A repeat control loop in which a number of statements are repeatedly
performed until the expression given evaluates to true.

Format

repeat <statement block> until <expression>

statement block one or more statementsin ablock. The block is terminated
by UNTIL
expression expression which can be evaluated to true or false (numeric
expression)
Example
repeat

let v = getv(driv1%)

until v = threshold

RETURN

Specifies the end of a script file subroutine. This statement takes no
parameters.

Format
return
Example
show:
flag “on”,1

return

Micropak 75XL User Manual 159



SETEDIT Using Script Files

SETEDIT

Allows data to be output to atest panel edit box.
Format
setedit <“identity”>,<data>

identity name of atest panel edit box (string expression)
data data to be output. Data must be O or 1 (numeric expression)
Example

setedit “DISPLAY”,0

SETFLAG

Allows data to be output to atest panel flag box.
Format
flag <“identity” > <data>

identity name of atest panel flag box (string expression)
data data to be output. Data must be O or 1 (numeric expression)
Example

setflag “STOPACT”,0
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SETPC

Sets up the value in the program counter of the target processor.

This command may be used to set up the PC just prior to performing test
execution of the target code.

Format
setpc <rom address>
rom address valid rom address for the processor (numeric expression)
Example
setpc 100

SETR

Sets up the value of the external resistance on apin.
Format
setr <pin number>, <value>
pin number avalid pin number (numeric expression)
value resistance value to be set, expressed in ohms (humeric expression)
Example
setr startpin%,10000
setr 9,10000
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SETV

Sets up the value of the external voltage on apin.
Format

setv <pin number>,<value>

pin number avalid pin number (numeric expression)
value voltage value, expressed in volts (humeric expression)
Example

setv startpin%, getv (Gnd%)

setv 9,5
SIN
Script file function. Returns the sine of a numeric expression (in radians).
Format
sin(<value>)
value input parameter (numeric expression)
Example

let a = sin(3.1415926/6) ‘would return (approximately) 0.5

SGN

Script file function. Returns the sign of a numeric expression.

If the expression is negative then -1 isreturned. If the expressionis
positive then 1 isreturned and if it is equal to zero then O is returned.
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Format

sgn(<value>)

value input parameter (numeric expression)
Example

let a = sgn(-10) ‘would return -1

SQR

Script file function. Returns the square root of a numeric expression. The
expression must be positive.

Format

sgr(<value>)

value input parameter (numeric expression)
Example

let a = sqr(13) ‘would return 3.605...

STOP
Stops the target code execution. There are no parameters.

Example

stop
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TAN

Script file function. Returns the tangent of a numeric expression (in
radians).

Format

tan(<value>)

value input parameter (numeric expression)
Example

let a = tan(3.1415926/4) ‘would return (approximately) 0.01371

TIMEOUT

Specifies atime-out value which will be monitored to trigger events when
the time-out expires. This facility allows the testing of time-dependent
routines in the target code.

Format
timeout (<value>)

value value of the time-out in seconds (numeric expression)

Example

let time% = timeout (0.010)
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XOR

Logical exclusive-or operator which performs a bitwise operation on two
integer operands. The truth table is as follows:

X Y XeqvVY
1 1 0

1 0 1

0 1 1

0 0 0
Example

let a% = b% xor c%
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Keyboard Summary

Editing keys

A completelist of the keys available for the editing function is given in the
chapter ‘Using the Editor’.

Accelerator keys

Here isasummary of the ‘accelerator’ keys used to provide fast access to
commonly used menu options:

File menu

Key Function
CtrI-N New file
Ctrl-O Openfile
Ctrl-S Savefile
Edit menu

Key Function
Ctrl-z Undo
Ctrl-A Redo
Ctrl-X Cut
Ctrl-C Copy
Ctrl-v Paste
Ctrl-F Find
Ctrl-R Replace
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Project menu

Key Function
Ctrl-F3 Assemblefile
Shift-F3 Link

Alt-F3 Rebuild all
View menu

Key Function

F4 Next error
Shift-F4 Previous error
Ctrl-F2 Toggle bookmark
F2 Next bookmark
Shift-F2 Previous bookmark
Test menu

Key Function

Ctrl-P Run script
Ctrl-Q Stop script
Debug menu

Key Function

F5 Go

F6 Step into

F7 Step over

F8 Step out

F9 Step to cursor
Alt-F5 Stop debugging
Ctrl-F9 Set PC to cursor
Ctrl-B Breakpoints
Ctrl-U QuickWatch
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Accelerator keys

Trace menu

Key Function

Shift-F5 Go (roll) back
Shift-F6 Step back into
Shift-F7 Step back over
Shift-F8 Step back out
Shift-F9 Step back to cursor
Ctrl-1 Signals zoom in
Ctrl-J Signas zoom out
Ctrl-T Snap signals
Window menu

Key Function

Ctrl-D Open device window
Ctrl-E Open pin window

Breakpoint function

Key

Function

F10

Set breakpoint
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Definition

Appendix A - Script file
grammar

Definition

This appendix shows the complete grammar of the script file language. It
encompasses a complete definition of the language of the script processor.

It is shown in modified Backus-Naur form.

file - statement-list EOF

script file: [statement-list]

statement-list: statement-list |abelled statement
|abelled statement

labelled-statement:  [label][statement] terminator

statement: close-statement
connect-statement
delete-statement
€lse-statement
else-if statement
end-statement
for-next-statement
go-statement
gosub-statement
goto-statement
if-endif-statement
|et-statement
poke-statement
print-statement
repeat-until-statement
return-statement
setpc-statement
setr-statement
setv-statement
stop-statement

terminator: \n

Micropak 75XL User Manual

171



Definition

Appendix A - Script file grammar

close-statement:
close-list:
connect-statement:
end-statement:
event-statement
for-next-statement:
for-statement:

step-expression:
next-statement:
go-statement:
gosub-statement:
goto-statement:
if-endif-statement:

if-statement:
elseif-statement:

€l se-statement:
endif-statement:
| et-statement:

on-statement

open-statement
poke-statement:
print-statement:

repeat-until-
statement:

return-statement:
setedit

close close-list

#expression

CONNect expression , expression

end

event event-number mode

for-statement [statement-list] next-statement

for identifier = expression to expression [step-expression]
terminator

step expression
next identifier
go

gosub label
goto label

if-statement [el seif-statement][ el se-statement] endif-
statement

if expression then terminator [statement-list]
elseif-statement elseif expression then terminator
[statement-list]

elseif expression then terminator [statement-list]
else terminator [statement-list]

endif

let identifier = expression

on event run |abel

open expression mode access lock AS #expression
poke expression , expression

expression

repeat terminator [statement-list] until expression

return

setedit expression

setflag setflag expression
setpc-statement: setpc expression
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setr-statement:
Setv-statement:
expression:
eqv-expression:

imp-expression:
XOr-expression:
or-expression:

and-expression:
not-expression:

relational -
expression:

additive-
expression:

multiplicative-
expression:

uni mus-expression:

power-expression:

setr expression , expression
setv expression , expression
eqv-expression

eqv-expression eqv imp-expression
imp-expression

imp-expression imp xor-expression
or-expression

XOr-expression Xor or-expression
or-expression

or-expression or and-expression
and

and-expression and not-expression
not

not not-expression

relational-expression = additive expression
relational-expression <> additive expression
relational-expression > additive expression
relational-expression < additive expression
relational-expression >= additive expression
relational-expression <= additive expression
additive-expression

additive-expression + multiplicative-expression
additive-expression - multiplicative-expression
multiplicative-expression

multiplicative-expression * uminus-expression
multiplicative-expression / uminus-expression
unimus-expression

- unimus-expression
power-expression

power-expression ~ unary-expression
unary-expression
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unary-expression:

identifier

real-constant

integer-constant

string-constant

abs (expression )

acos ( expression )

asin ( expression )

atan ( expression )

breakpoint ( label , expression, expression , expression ,
expression , expression , expression )

breakpoint ( label , expression, expression , expression ,
expression , expression , expression , expression )
button (expression)

cos ( expression )

edit ( expression )

exp ( expression )

flag ( expression )

getedit ( expression )

getfx ()

getfxt ()

getpc( )

gettime ()

getv ( expression )

input # expression

peek ( expression)

pin ( expression)

sin (‘expression )

sgn ( expression )

tan ( expression )

timeout( expression )
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Appendix B - Script File
Example

ren]********************************************************

rem File : stepper.scr
rem Desc :

rem File for demonstration of the MP75X simulator

raﬂ*********************************************************

raﬂ*********************************************************

rem Allocate vars to pin numbers. By allocating variables with
rem pin numbers, makes the script file easier to understand.
POV Kk ko ok ok ok ok ok ok ko ko ko ko ok
let driv1% = 46 : rem the stepper motor drive
let driv2% = 47 : rem lines
let driv3% = 48
let driv4d% = 49

let Vdd% = 54 : rem the power supply lines
let Gnd% = 33

let startpin% = 42 : rem the lines which the rea
let stoppin% = 43 : rem switches are connected to

raﬂ*********************************************************

rem Set voltages on pins and make connections
raﬂ*********************************************************
setv startpin%, getv (Vdd%) : rem both switches made inactive
setv stoppin%, getv (Vdd%) : rem (high)
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setr startpin%,10000 : rem resistance = 10K

setr stoppin%,10000

connect startpin%,1 : rem alow the script fileto
connect stoppin%,1 : rem change the lines

rern*********************************************************

rem Assign button IDs to run pieces of script files. Soif a
rem button is pressed in atest panel the relevent script
rem commands are processed.
rem STARTBUTTON and STOPBUTTON are the ids given to the panel
rem button. actstart and actstop are the labels for the script
rem file functions.
POV koo ok ok ko ko ko
start% = button("STARTBUTTON")
on event (start%) run actstart
stop% = button("STOPBUTTON")
on event (stop%) run actstop
event (start%) on
event (stop%) on
POV Kk ko ok ook koo
rem Any changes to voltage on the motor drive lines will call
rem the appropriate script routine.
POV Kk koo ok ko ko ko ko
d1% = pin(driv1%)

on event (d1%) run showl : rem pin 46
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d2% = pin(driv2%)
on event (d2%) run show?2 > rem pin 47
d3% = pin(driv3%)
on event (d3%) run show3 rempin 48
d4% = pin(driv4%)
on event (d4%) run show4 :rempin 49
event (d1%) on
event (d2%) on
event (d3%) on
event (d4%) on
PO * 44 koo koo ko ko ko ko
rem If the user changes the power supply change the switching
rem threshold.
PO * 4+ ko koo koo ok ko ko ko
V% = pin(Vdd%)
on event (V%) run adjthes
G% = pin(Gnd%)
on event (G%) run adjthes
event (V%) on
event (G%) on
PO 4%k koot koo ko ok ko ko
rem The following section of script codeisto produce a
rem breakpoint which has to be hit 5 times before it stops
rem execution and warns the user in the dialog box of the test

rem panel
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rern*********************************************************

let bpcount% =5 > rem set up initial count
b1% = breakpoint("LOC",1,"stepper","PC",0,"="," SetPhase7")
on event (b1%) run pc_brk
event (b1%) on : rem set up the bp, which when

: rem the program counter is

: rem about to hit SetPhase?,

: rem the script code at pc_brk

‘remiscaled
let threshold = (getv(V dd%) + getv(Gnd%)) / 2
go :rem start execution of the program

end
PO * 4%k koo koo ko ko ko ko
rem The following script routine is called when the program
rem hits the set_phase 7 breakpoint.
PO * 4% koo koo ko ko ko
pc_brk:
let bpcount% = bpcount% - 1 : rem decrement bp count
if (bpcount% = 0) then : rem check the count
stop : rem if O stop execution of
: reminstructions, initialise
let bpcount% =5 : rem count back to 5
: rem report to the user that the bp has been hit
setedit "DIALOG", "Breakpoint hit"

endif
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end : rem end of thisroutine
PO * 44k koo koo ok ko ok ko ko
rem The following script routine is called when the threshold
rem needs to be changed
PO * 44k ok koo ok ok ko ko
adjthes:
let threshold = (getv(Vdd%) + getv(Gnd%)) / 2
end
PO * 4%k koo koo ko ko ko
rem Highlight the flags showing the phases of the stepper
rem motor.
rem MOTOR1, MOTOR2, MOTOR3 and MOTOR4 are flag ids
rem in the panel. A value of 1, highlights the flag, a 0 will
rem turn the highlighting of the flag (segment) off.
PO 4% koo koo ko ko ko ko
showl:
setedit "DIALOG","phase 1"
if getv(driv1%) < threshold then
setflag "MOTOR1",0
else
setflag "MOTOR1",1
endif
end
show?2:
setedit "DIALOG","phase 2"
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if getv(driv2%) < threshold then
setflag "MOTOR2",0
else
setflag "MOTOR2",1
endif
end
show3:
setedit "DIALOG","phase 3"
if getv(driv3%) < threshold then
setflag "MOTOR3",0
else
setflag "MOTOR3",1
endif
end
show4:
setedit "DIALOG","show4"
if getv(driv4%) < threshold then
setflag "MOTOR4",0
else
setflag "MOTOR4",1
endif

end

rern*********************************************************

rem Script code called when the Start button is pressed.
rem Checks that the 1/O line isinactive (HIGH).
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rem If inactive makes the line active. Shows the new status.
rem After 0.010 seconds (10ms) runs script code to deactivate
rem 1/O line
PO * 44kt ko
actstart:
if getv(startpin%) > threshold then
setv startpin%, getv (Gnd%)
setflag "STARTACT",1
t2% = timeout (0.010)
on event (t2%) run inactstart
event (12%) on
endif
end

raﬂ*********************************************************

rem Code to deactivate 1/0O line and show the new status.
PO * 4% koo koo ko ko ko
inactstart:

setv startpin%, getv (Vdd%)

setflag "STARTACT",0

end

raﬂ*********************************************************

rem Script code called when the Stop button is pressed.

raﬂ*********************************************************

actstop:
if getv(stoppin%) > threshold then
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setv stoppin%, getv (Gnd%)
setflag "STOPACT",1
t1% = timeout (0.010)
on event (t1%) run inactstop
event (t11%) on

endif

end

inactstop:

setv stoppin%, getv (Vdd%)

setflag "STOPACT",0

end

raﬂ*********************************************************

rem End of script file

raﬂ*********************************************************
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Index
type field, 86
—A—
—C—
accelerator keys, 53, 65, 161

bookmarks, 73 check boxes, 53
breakpoints, 163 controlling execution, 75
Debug menu, 162 customised memory views, 100
Edit menu, 161
File menu, 161 —D—
Test menu, 162 Debug

Trace menu, 162
View menu, 162
Window menu, 163

breakpoints, 85
fast mode, 33, 76, 79
options, 76, 79, 82

_B_ reset, 78
slow mode, 33, 76, 77, 79

batch file, 57, 58 debug information file, 58
bookmarks Debug menu, 31, 46, 49, 78, 85,

clear, 73 162

next, 73 go, 32, 37

previous, 73 debug mode, 33

set, 73 dialog boxes, 51
breakpoint, 36, 37 directory structure, 6
Breakpoints, xv, 10, 11, 36, 40, 49,

58, 75, 81, 85, 162 —E—

accelerator key, 163
break at location, 86
break at location if expression is

Edit menu, 46, 47, 161
editing a project, 60
editor

tr .
e, 8 keyboard functions, 70
disabling, 90 . A
. locating and changing text, 71

enabling, 90 .
removing, 90 options, 68

oving, =9 enabling signal buffer, 103
script file facilities, 91 .

; execution
setting, 90
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ceasing, 75

controlling, 75

go, 76

optimising speed, 75

restarting, 83

step into, 76

step out, 76

step over, 76

step to cursor, 76
external project options

build mode, 63

debug build, 63

processor, 63

release build, 63

target name, 63
external projects, 57

— F—

file defaults, 66
File menu, 46, 47, 108, 161

open, 65
—H—

Help, 55
Help menu, 46, 51, 55

inactive trace buffer, 83
installation, 5
internal project options, 61
Assembler, 62
build, 62
C compiler, 62
category, 62
C-Like compiler, 62
Linker, 62
options string, 62

internal projects, 57
interval, 79
interval window, 79

—K—
keyboard summary, 161

L —

list boxes, 53

locals, 112

locating and changing text
find, 71

locating and finding text
bookmarks, 73
find/replace again, 73
replace, 72

— M—

menu operation, 45

—0O—

on-chip peripherals, 105
opening a project, 59
opening files, 65
Options
Debug, 76
Options menu, 46, 50
debug, 76, 79, 81, 82
editor, 638

—p—

pin and port windows, 93
pin numbering, 96
plot lines
disabling, 103
enabling, 103
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removing, 103 re-building the project, 74
port registers, 116
script files, 95, 96 roll-back displays, 82
views, 93, 106 go back, 82
windows, 93 step back into, 82
port simulation techniques, 93 step back over, 82
processor information file, 58 step back to cursor, 82
program counter, 77, 78 step out, 82
indicator, 31 runtimelinks, 6, 7
project, 34
batch file, 57, 58 —S—
depug information file, 58 script file, 22, 107
edit, 60
commands, 80
external, 61, 63
. events, 124
internal, 61 .
execution and control flow, 124
open, 59

script file variables, 121

script files, 23, 35
breakpoints, 91
examples of uses, 118

processor information file, 58

source files, 58

window configuration file, 58
project files, 57

identities, 128
external, 57
. port, 95, 96
internal, 57 urpose and uses, 117
Project menu, 46, 48, 74 burp ‘
test panels, 117
execute, 35

script language

pull-up control, 96 breakpoints, 125

—Q— button events, 125
comment delimiters, 120
quick watch, 111 edit events, 126
add to watch, 112 elements of statements, 120
modify variable, 112 grammar and syntax, 119
zoom, 112 keywords, 130
operator precedence and
—R— associativity, 123

operators and expressions, 122

radio buttons, 53 pin events, 126

RAM .
. . statements and lines, 119
customised memory views, 100 .
. timeout events, 127
window, 99
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script language commands and STOP, 157
functions SYMBOL, 157
ABS, 133 TAN, 158
ACOS, 133 TIMEOUT, 158
ADD, 141 XOR, 159
AND, 134 setup, 5, 7
ASIN, 134 signal, 24
ATAN, 135 buffer, 103
BREAKPOINT, 135 recording box, 101
CONNECT, 138 zoom in, 104
COS, 138 zoom out, 104
EDIT, 139 signal buffer
EDITS, 139 control, 80
END, 142 signal plots, 24
EQV, 142 signal recording box
EXP, 142 axes and scales, 102
FLAG, 154 disabling plot lines, 103
FLAG-TO-[STEP], 154 enabling buffer, 103
GOSUB, 145 enabling plot lines, 103
GOTO, 145 markers and shading, 102
IF-THEN-[EL SEIF]-[EL SE]- pin selection, 103

ENDIF, 145 removing plot lines, 103

IMP, 147 setting up, 101
LET, 148 viewing the results, 104
NOT, 148 Signal window
OR, 150 control, 80
PEEK, 150 source debugging, 111
POKE, 151 call stack, 111
PUT, 151 locals, 111
REM, 151 quick watch, 111
REPEAT-UNTIL, 153 registers, 111
RETURN, 153 watch, 111
SETPC, 155 source files, 58
SETR, 155 step
SETV, 156 multi, 32, 75
SGN, 156 single, 32, 75, 82
SIN, 156 Step Into, 32, 76, 77
SOR, 157 Step Out, 77
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Step Over, 76, 77

Step to Cursor, 31, 76, 77

syntax colouring, 67

S

Test menu, 46, 49, 50, 108, 162

test panel, 21, 107
button, 109
edit box, 110
flag, 109
move, 109
options, 108
properties, 110
setting up, 108
text box, 109

test panels

examples of uses, 118

trace buffer
control, 80
inactive, 83

trace buffering, 37, 81

Trace menu, 24, 46, 162
roll-back displays, 82

—U—

user interface, 41
desktop, 42
icon, 42
keyboard, 53
menu, 42
menu bar, 42
menu operation, 45
scroll bars, 43
status bar, 43
tool bar, 42
toolbar, 54
window, 42

window elements, 43

—V—

View menu, 46, 48, 162
viewing simulated objects, 99

—W—

watch, 112

adding items, 112
window

interval, 79

window configuration file, 58

window el ements, 43

Window menu, 24, 46, 51, 79, 163

device, 99, 106
registers, 116

Micropak 75XL User Manual

187



